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Foreword

Most present —day design is carried out using computer program. This
book offers a lucid and coherent presentation of the most famous
program of high-rise building (ETABS v9). This book is based on
ETABS v9 and applicable to Etabs v§. The book contains detailed
example of 40 story tower and detailed explain for the most important
utility of the program (Like design, Dynamic analysis) without
descanting due to the limitations on the size of the book without any
effect of the purport.

I didn’t take about the codes details because this out of the scope of
this book but I mention any data required from the codes through the
* book chapters.

I attempted to not repeat explanation of some point many times but [
refer to the explanation of this point when it is repeated.

I used the step-by-step instruction guide though development of
ETABS model to show how quickly and easily a model can be created
using this program.

The book contain the very important nonlinear analysis called
sequential construction and explanation of the difference between the
normal analysis and Sequential construction analysis, and also contain
explanation of the ability of the program to work with any different
sections, and how to define this sections to the program .

I explained through this book the program ability to transfer
information from the ETABS database for use with other software
package.

Makar Nageh
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

An Ekample Model

e In this Example we will built the model shown in the figure. Each
step of the model creation process is identified, and various modal
construction techniques are introduced. At the completion of this
Example, You will have found that, it is so easy to built Etabs
model in a few hours.

e The step by step instruction will guide you through development
of your first model
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Chapter 1

The Example Project

* The tower of our example is 40 story building.

* The first story height is 4.2m and the typical stories height is
3.4m.

e The lateral force resisting system consists of 8 Shear walls,4 L
shear walls, and 1 core wall

¢ The plans of the tower floors as shown blow

7
s

~
: s,
s <
| | '
3 <
< N N > . <
z e P -
. -
N o ~
~ - - -
- 7 > N P .
. - . ; -
N N
N
N N SRR
N2 L IEN

N T
N . N
NS N RN N L N
, p : . -
z N N_J\ v ”
N 7 . oo
Y .
~ ~
A N i
N
ror
N

From level 1 to level 23

VIETCONS

TRUNG TAM PAO TAO XAY DUNG VIETCONS VIETLUINS
www.vietcons.edu.vn



HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Step 1: Begin anew model

¢ In this step, the dimensions and story height are set.

1.
2.

4.

open the program

Check the units of the model in the drop-down box i the
lower right-hand corner of the Etabs window , click the
drop-down box to set the units to KN-m  ripe

K.gf-ram
K.igf-m
M-rarn
M-m
Toremm &

Kip-in =/

Click the File menu — New model command Or
the New Model button p the form shown in figure will be
displayed

New Model Initialization

the next form of Building Plan Grid System and Story
Data Definition will be displayed after You select click
NQO button

o

- ——
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e In the form of Plan Grid System and Story Data Definition you
can: ‘

1. Set the Grid Dimensions(plan)

e Set the Number of Grid lines in X direction in the
Number of lines in X direction edit box =11
(Horizontal Grid)

® Set the Number of Grid lines in Y direction in the

Number of lines in Y direction edit box =11(Vertical
Grid)

e Set the Spacing between Grid lines in X direction in
the Spacing in X direction edit box =4 m

* Set the Spacing between Grid lines in Y direction in
the Spacing in Y direction edit bex =4 m

™2
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

2. Set the Story Data

¢ Set the number of stories, in our example we have
40 stories building so that we will set the number of
stories in the number of stories edit box equal to 40.

e Set the story height Set the Typical Story Height in
the Typical story height edit box to 3.4 m

e Set the Bottom Story Height in the Bottom story
height edit box to 4.2 m

¢ You can change any story height by choose custom
story data , then click on Edit Story Data, the
program will open the form of all stories level, we
'will change the height of 23" floor (mechanical
floor)to 4m

TRUNG TAM DAO TAO XAY DUNG VIETCONS M |ETCON S
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And also in this form we can adjust similar story, our master Stories
is levell, level 23, level 39, level40

5. Select the Grid Only button

6. Click the OK button to accept your changes. Your Model
appears on screen in the main ETABS window with two

view window, plan view and 3-D view as shown in the
Figure.

.

U e WG

Define the Codes Used in the design of the Building:
In this step, we will define the codes used in the project, to define
the properties of material according to this code, and make the

program create the load of combination automatically according to
this code, and use this code for design
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

1. Define the code for design The Frame Elements

Click the Option menu — Preferences —»
Concrete Frame Design

Dimensions/Tolerances. ..
Cutpat Dedmals...

Windows

Set Calodator Memory.. .

—omposite Beam Design...
Shear Wall Design...

' Show Tips st Starbup

Show Bounding Plane

Reinforcement Bar Siges. ..

Live Load Beducton.. .

‘Moment Diagrams on Tergion Side

This will Display the Concrete Frame Design Preference
Form as shown in the figure.

Diesign Code , 01 e-e9

Time Histoe Desion Erpeslopes
Flumbsr of Interartion Curves 24
Flumber of Interachon Fordz 11
Corgider inimum Ecoenticity "es
Fhi [BerdingTersion] A
Ph [Crrnpression Tred) 0y
FhiComperesnon Spisf) 07
P [Sheas) 0Es
Pattem Live Load Factor 07
Uifization Factor Lirit .95

Cancel |
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| Chapter 1

From this form, you can adjust the code and the another data of design
according to the requirement of design, and in our example we will
choose the ACI 318-02 as a code of our design »
* Click the drop-down box of the design code to set the code
(ACI 318-02)

Design Code ACI 1805480 2 v |
AT TTEEABE 20 A
i -~

P 4
LIRCS7
BSE110089
BSE110 57
C54:423 394

EUROCODE 219 %

® Repeat the same steps for assigning the code of design for
shear wall design from the same menu

- Dimensions/Tolerances. .
. QutputDecmals. .

. Steel Frame Design...
- Congrete Frame Design. .,

. Composite Beam Design...

Reinforcement Bar Sizes...
_ Liwe Load Reduction. ..

¢ Step 2: Define the Materials & Sections
In this step, we will define the materials, and the sections of Walls
Slabs, and Beams of the structure

2

1. Define of materials

Note: we will use in our model 2 different types of concrete
* Concrete grade 60000 KN/m? for wall columns
e Concrete grade 40000 KN/m2 for Slabs Beams

{3

VIETCONS

ALWAYS BESIDE YOUR SUCCESS

TRUNG TAM BAO TAO XAY DUNG VIETCONS
www.vietcons.edu.vn



HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

1. Click the Define menu —— Material Properties

Click Add New Material button to Display the Material
Property Data form which is shown in the figure.

he definition
will be

according to

ACI 318-02

el TRUNG TAM BAO TAO XAY DUNG VIETCONS VIETCONS
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| Chapter1 |

e Define the material properties in that form to be according
the design code. '
e Concrete grade 60000 KN/m? for wall

Matueial N
Tope of Madesid : : Tyre o Dhpesin

Do Property Doarg 1005 29505

* Repeat the previous step, Click Add New Material button to
define the concrete for slabs (Concrete grade 40000 KN/m® for
Slabs Beams) and fill the form to be as in the figure

¢ Click the OK button to accept your changes. Thin You will find
the new materials were Add

o i
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

The new

material

was been
add

¢ C(Click the OK button to accept your changes.

2. Define of sections(Walls, Columns,Slabs,Beams)

2 Wall Thickness .
1. Wall 400=40 cm
2. Wall 500=50 cm

2 slab Thickness
1. Slab 250=25 cm
2. Slab 200=20 cm

1 Beam Size (For Beams and Spandrel beams)
1. B (400X900)

1 Column Size
3. C400x400

®

®

1. Define of the Walls section :

1. Click the Define menu —p Wall/Slab/Deck Sections

®

o

Pt
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7€, [Material Properties. .,

rame Sections.

Fr-ame P-Jn:xniihe ar Hinge Properties. .,

Or Define Wall/Slab/Deck Sections button 7z Which will Display the
define Wall/Slab/Deck Sections form

- Seclions

Chek b~

| 8dd Mew Dreech

Modifu/s hove Section. .

Delete Section

2. Click the drop-down box that reads “Add New Deck”

Choose Add New Wall from the list, thin the form of Wall
define will be opened

T e

AM B AY DU IETCONS
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Section Hame im

Haterial CS'TEEL i

- Thickness -
bembrane 31 '
Bending il
e
% Shel " Membware

7 Thick Plate

o Lovad Distibution -

I Use Special Unedway Load Distibution |

SetModfiers. | Display Color B

[ o ] Cancel |

¢ In this from change the section name to wall 50
e Click the drop-down box of material and choose
conc. 60

e Define the thickness of wall =.5 m
e The form will be as shown

wevion Boeos

To make any stiffness
rmodification according to
the codes

3
o, ¥
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e Click the OK button to accept your changes.
e Repeat the same steps for the wall 40 cm thickness and the form
will be as shown in the figure |

WallStab Section .

Section Name

3“«»&&40

I Thick Plate

taterial jconcen vd
~ Thickress
Membrane i 4 V
. ]
Bending 4
o T}’ﬂe

4% Shel 1 Membrane: £ Plate

-~ { aad Distribution

Mlse Sperﬁal Ore-wWay Load Distribution

” 1
Set Maodifiers... |
SO E—.

ok |

Display Color |

Cancel %

e Click the OK button to accept the changes. and the program
automatically will add the new sections to the list of the sections

- Bectiong e

DECK
PLANE]

Carcel |

TRUNG TAM DAO TAO XAY DUNG VIETCONS
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

2. Define of the Slabs

1. Click the Define menu ——p Wall/Slab/Deck Sections

& Material Properties...
5

E
s

Frame Nonlinear Hinge Properties, ..

Or Define Wall/Slab/Deck Sections button 2

j v ¥

which will

Display the define Wall/Slab/Deck Sections form

: G B R e

DECKY ’«"
FLAMED ]

SLABT

'ALLT

P Chicke to

ddfewiial

Modify/Show Sectior. |

WALLAD'
ol LR

Dedete Section i

Canel

2. Click the drop-down box that reads Add New Deck

Sechors - : e Chehk b

WALLAN

TRUNG TAM DAO TAO XAY DUNG VIETCONS
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Choose Add New Slab from list thin the form of Slab define

will be opened

. SectionHame [

: &iéﬁaria(

- Thickness-

tembirane

Bending

Type

7o Shell T Membrane 4 Plate
I Thick Plate

-~ Load Distibution

T Use Special Onedway Load Distribution

Set Modifiers,.. % Display Colar

m ’~Canceﬁi ; o

S v Rame

khasmed

TRUNG TAM PAO TAO XAY DUNG VIETCONS
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In this from change the section name to Slab 25
Click the drop-down box of material and choose conc. 40
Define the thickness of the Slab =25 m
Thin the form will b h
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e Click the OK button to accept your changes.
e Repeat the same steps for the Slab 30cm thickness and for the Slab
20cm thickness thin the sections will be add to the section list
e Click the OK button to accept the changes
[iaﬁhe Wai s iéhiﬁeck 5ecimvn§ I

3. Define ofzhe Beams

3. Click the Define menu ——p Frame Sections ....

Or Define Frame Sections button T which will Display the
define Frame Sectlons form

- 2 - o !
,g},r‘r\{:zg} 0 . o 1 ladd Angle
Thw . ' g - Add Double Angle

\ r-'Praﬁerlée@
You can L
pe i property bofind -
remove the
template e
" ~ L.GravBm
section b_y A-GravCol ;
click on the T T | addIideFlangs )
’ =Tk 10 ; L - 4 : & D1 3 @3
Delete ATiChdw12 e ] e Iégfme-?dnge a2
L-TiChdw14 o ' =B A by
Property e = dild Tee =
|
!

1 |add BowTube

‘ ) i !
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3. Click the Second drop-down box that reads Add I/Wide Flange
,Choose Add Rectangular from list thin the form of Beam define

Chapter 1 |

will be opened

Rgctémgular Section

N

|STEEL

Note: we will define the Beam Dimension (0.4x0.9) \
e In this from change the section name to be B40x90

¢ Click the drop-down box of material and choose conc. 40
e Define the Dimensions (0.4x0.9),thin the form will be as

g
h

shown

{B400900

|

CONTAT: (g

M TN

Display Color

Section Name :
i~ Propertie i Property Modifiers - — Material
S ection Properties... i i § 5 et Modifiers: 3 ;
i i i
- Dimensiors : s
 Depth [13) o3 ;
Width (12) _los
-~ Concrete N
Reinforcement.. =0 - g .
ok ] Cancel |

TRUNG TAM PAO TAO XAY DUNG VIETCONS
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e Click the Reinforcement button to Define the Design of this
Section

Reinforcerent Data

e In this form click Beam and define the cover for reinforcement to
make the form like the next form

27
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e Click the OK button to accept your changes. and Ok for main form
,you will find the Section already Defined |

- Properties ~Click tor
 Type in propetty to find Y -
. E iﬂ_ ey o Hmport | Aefide Flange M
(B A0E00 : i
iudd Fectangular -

Modity/Show Properiv..

Carcel |

e Repeat the same steps to define the spandrel beam
(the beam connecting the core walls because it will
be casted with walls of the core so that the concrete
grade of this beam will be conc. 60 and the
reinforcement of this beam be different than the
normal beam

After you add this beam the form will be

Section Name {5B40H430
- Propertigs —---" - Property Modifiers —1. Materiai"‘ww”"“MWWMWW : "’ L
Section Propetties.. | w Set Modifiers... 3 | CONCED Ra
: - Dumenstons
Depth (131 0.9
width [12) -
'f-,«
¢ Conciete— e
Fenforcement. .. § . )
Dizplay Color
oK Cancel |
TRUNG TAM BAO TAO XAY DUNG VIETCONS VIETCONS
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

4. Define of The columns
To define the columns follow the same steps of defining the

; beams
1. Click the Define menu ——p Frame Sections ....

Define

Lipk Properties..

Frame Monlinear Hinge Properties. ..

Or Define Frame Sections button "I which will Display
the define Frame Sections form

LS 1ide Pl

4. Click the Second drop-down box that reads “Add I/Wide Flange”
,Choose Add Rectangular from list thin the form of columns define
will be opened

NCOMCED |
conc

o
ot
4o

TRUNG TAM DAO TAO XAY DUNG VIETCONS VIETCON S‘I_
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Chapter 1

e In this from change the sectlon name to be C400x400

e Click the drop-down box of material and choose
conc. 60 '

e Define the Dimensions (0.4x0. 4)

e The form will be as shown

REL tanguiaa Sertion

 SectionName [Caoaxann

- F’maertne" ?»f*—"%-mw—j—ﬁ% i Property Madifiers e 5 tdatenal
SetModfies.. | | | Joonces =]

Section Praperties... i i

+Dimensions ——
Depth (13]

kW’i’dthk,{‘t?} , ;4 - ;

~Concrate———— e
‘ Feinforcement . i k

""‘k,wDispt:ay Color -

- o I oK - i : Cancel }

e Click the Reinforcement button to Define the Design of this

Section
::w 1 Cared |
30
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e In this form click column and define the cover for reinforcement,
number of bars in each face, and bar size to make the form like
the above form

e Click the OK button to accept your changes. and Ok for the main
form :

o Step 3: Add the Geometry of the Tower

In this step, we will draw the Structure elements

1. Add Slabs, Walls Beams:
You have 2 methods to add the structure elements to the program

a. By using the program drawing tools
b. By using DXF file which is creating by AutoCAD
Program |
NOTE: 1 Will Explain How to Draw the Structure Element Using
AutoCAD Program because most of engineers are familiar with this
method. And I will take about the program utility in the chapter of
important notes
1. Open AutoCAD Program
2. Open the File of the plane for the first floor or open new file in
AutoCAD Program and make 4 deferent layers
1. Beams : for beams and walls
ii. Floor  :for slabs
iii. Opening :for the openings
iv. Columns : for the columns
3. Draw PLINE on the edge of the slab in the layer Floor, you
dont need to draw 3D Face a nd mesh it yourself ,we will make
the program make automatic mesh for the elements

Direction of Drawing

The PLINE of the slab
\4 >
31
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| Chap.ter 1

4. Draw the beams and walls as lines in the layer called beams,
and if you have columns draw it as a line in the 3D

Direction of Drawing » g
The beams and the :
Walls lines

5. Draw the openings in the layer called opening as PLINE on
the edges of the openings

= |PLINE for the| e
2 edge of the ] -
siab I . Lines for
: it beams and
walls -

R @5‘*« T R G BUR R e ‘ a,%@

6. save the file as DXF file named Examplel

7. Click File menu ____, Import____, DXF floor plan,
which will Display the Import DXF File form

NOTE: Before Exporting the DXF to ETABS Program , make sure
that the referance point of (0,0) is the Same as the model
referans point (0.0), if not move all the Drawing from the
reference point (intersecting the grid (A,1)) to (0,0)

a2
™
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Choose the file of DXF and Click Open; thin DXF Import Form will
be displayed

33
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Chapter 1

| | coondSystem [GLOBAL <] | DXFFisUnks  JKNm ~]

We ‘ ‘ ;‘:'Seiec‘tf.ayé(:;:fm Grids—— : = Default Propetties — i
dont ’ . AMS TN "Seam Properi’iés‘ / ; BAKID ‘:j
have Columrs 3 N i Column Properties %BACV»SU ~ i
CO‘UmnS L Floors f,\ iFLODF{S v,; FlborPrdpe:rtieg - :
in this | Dpenings ] g L L

floor -

: : L o ~Plari Location -
Globafuf:x Direction. - {Z ] Stany Level

|  "Tign“?‘leLinesys‘ﬁo:ieﬂ"han o :

8. MM@smemmﬂwmeWmvmﬂwvmwofmxyLﬁmﬁCmm
set plan view button P thin the next form will be displayed,
from this form choose story 1,thin click OK

S.eieﬁt Plan Lewal

~ [STORYIO

|STORYS
|sToRvYE
- {STORY?
| |STORYE

{STORYS
ISTORY4
|STORY3
{STORY?

. ’ B'&.SE . i ity
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

| -
e § The slab
limits
The 5 -
centre | , A
line of z
the wall L .

9. Choose the wall centre line thin click Edit menu —— .
Extrude Lines to Areas thin the next form will be displayed

From this form change the dz equal to the height of the floor by (-)

sign and highlight the Delete Source Objects check box and the
number of divide the walls make 1 thin click OK

-
=
s

£F

AM D/ A IETCONS
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Extrude Lines to Areas

The walls
after
extruation

10. Assign of the sections

e Choose the slab and click Assign menu ——p Shell/Area
______» Wall/Slab/Deck Sections
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Assion Wall/Slab/Deck Sections

e choose SLAB 25 thin click OK button
e to assign the walls thickness

o Choose the outer Walls and click Assign menu —p .
Shel/Area —» Wall/Slab/Deck Sections

o Choose Wall 50 thin click OK
o Choose the Core Walls and click Assign menu —p
Shell/Area — Wall/Slab/Deck Sections

Assion Wall/Slaby/Deck Sectiens
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" Chapter 1

e Choose Wall 40 thin click OK

e To assign the Beams Dimensions

Llsdtigesi 9,

e

|
i
e
v

¢ Choose the Long beams in the core and click AsSign menu—-yp.
Frame/Line ——» Frame Section
As :}%rﬁmﬂ?é S »

s Properties o e Click o

: i o find: o
: §Type in propety 1o find L }rlmport [ffide Flangs
. |B40XS0 ] - =TT

- i
N PR

| &dd 1 Awfide Flange

e ;
;‘éﬂggduo : F Modify /Show Fropaly... }
SR4490 7
|
Bt
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

¢ Choose B 40X90 thin click OK
e Choose the short beams in the core and click Assign menu —_,
Frame/Line ——— Frame Section

e Choose SB 40X90 thin click OK

11. Replicate of the story

e Choose this floor and make replicate to other floors. Choose the
floor by window or click Select menu — select by story level
thin choose the story from the form thin click OK

Seieatfgtmy Level

ISTORYI0

* Thin click Edit— replicate. the next form will be displayed

39
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Choose story and the story you want to replicate this floor in it (from
story 1 to story 23), thin click OK

Replicate

12. As it is mentioned in the begin of the example the story 23 is
mechanical floor so that it is needed to reassign the slab
thickness again by choose the plane of the floor in plane view ,
Click set plan view button PR thin the next form will be
displayed, from this form choose story 23.thin click OK
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e Choose the slab by click on the slab in plan; thin repeat the
' same steps for assign the slab and assign the slab to be slab 30.

13. Draw other floors as we explained in the previous steps as DXF
files and repeat the same steps for import and replicate.

¢ In the story 39 which have columns ,you have 2 choice to add
this floor
1. replicate the floor of the story 38 to story39 thin erase the
edge walls and click Draw menu ——» Draw Line
Objects ——»Create Column in Region or at Click
(plan)

Draw

Select Object
T Reshape Object
L |

®; Draw Point Objects

™ Draw Lines {Plan, Elev, 30)
¥ create Lines in Region or at Clidks (Plan, Elev, 30)
.-3 Draw Developed Elevation Definition. . St e Ll s

oy Enoedion £ ot =5 Creste Secondary Beams in Region or at Clicks (Plan)

Draw firea Objects

¥¥ Draw Dimension Line

*_ Draw Reference Point -

Snap to k »]

41
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Or click Create Column in Region or at Click (plan)
button {# | thin the carser of drawing will be displayed and
also the form of the properties of the column, from the drop
down box of Property choose the column section C40x40

% F’myperty Ba0=050 k
| tdoment Releases Contirous

L dngle 0.
| Plan Diffzet ¥ 0.
| Flan Olffzet v 0.

Thin click on the position of the column

Click on the
column
position

e Add the Beams
1. Click the Draw menu ——p Draw Line Objects

— % Draw Lines

&z in Region or Flan. E
‘eate Columns in Region or 3t Clicks (Flan)

! Create Secondary Beams in Region or at Clicks Flans

srEicn Ling i : ‘ ———

& Draw, roe Foind

Snas E
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Or Draw Area button ™~ which will Display the
Properties of Object form as shown in fig. and crasser
for drawing Area

| Type of Line Frame

| Froperty ELatbm

| Moment Feleases Continuous

2 Plarn Dffset Normal 0,

§ Drawing Cantrol Type Mone <space bar

| |

¥ In previous form you can
1. Choose Type of Line (Frame)
2. Choose the Property of the Line
(B40x90)
Thin click on the first point of the beam thin click on the second point
thin you will find the beam created

Click for the first
point

Click for the
second point

Second method for the add the columns to draw the columns in the
DXF file in 3D thin imported to the Tabs Program as explained before
For the story40 replicate the core walls and draw slab on the edge
of the core or repeat the same step or create DXF thin imported to
the Etabs program..

v
L & =%
&
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Step 4: Meshing &assign id the Diaphragm

Meshing
There are 2 types of meshing

1. manual meshing
2. Automatic meshing

e for walls, it is better to make manual meshing

e for slabs, it is better to make automatic meshing

Note: the important thing you must do it before the meshing to create
secondary Grids for the structure to be as a guide for the meshing

To create the secondary grids

e Select the whole structure or you can select only the point you
want to it to be guide for the meshing

e Click the Edit menu —» Edit Grid Data——» Add Grid at
Selected Points

o o
Edit Story Data ;
Edit Reference Planes...

EditReference Lines... | v Lock OnScreen Grid System Edit

¢ Thin from next form choose Orientation Parallel to X, thin repeat
the same step with orientation parallel to Y

Add Grid Lines at Selected.

_Coord System | GLOBAL vi

‘ ~Drientéti ay
7~ Parallel to
% _Parallel toy

Cancel §
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

1. Meshing of the walls

e Choose the whole walls ,click select———» by area
object type, thin the next form will be displayed

Select z‘-trea {?bjegt Typ*g :

e (Choose wall thin click OK

o Click the Edit menu —®» Mesh Area the next form
will be displayed

| Obie -
- i intersections with Selected Line Objects

45
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¢ From this form choose Mesh Quads/triangles at
¢ Intersection with Visible Grids
e Seclected Point Objects on Edges
¢ Intersection with Selected Line Object

e Thin click OK and display any plan to see the
meshing of the walls

¢ If you want to add farther subdivide to the walls
select the walls again and display the form of the
meshing thin select the third choice of Mesh
Quads/Triangles into, thin give to the program the
size of the mesh which you want to mesh the walls
by this size

©  Meshing Optiong -

775 Cookie Cut at Selected Line Objects (Horiz}

. Degress Horz.]

{3 Cookie Cut at Selected Pod

2

{55 Mech Quads/Trangles into 1€ by rL\ | Breas

The size of the
mesh

Foor | Cancel |

2. Meshing of the Slabs

Note: for slabs we will make automatic meshing

¢ Choose the whole Slabs walls ,click select ——— by area
object type, thin the next form will be displayed

7
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Carcel

¢ (Choose Floor thin click OK

e Click the Assign menu———- Shell/Area — Area

Object Mesh Option
Assign

Joint/Foint " §

Framefling b

&5 wiall/slab/Deck Section, .,

Joirt/Point Loads 2 =l Dpening...
Frarme/Lire Loads p =) Rigid Dizphragrm...
ZF Local fwes.,.

Shellféres Loads 3

Shell Stiffness Modifiers. .,

5 Group Mames..,

; v of 0 Figr Label...
Clear Display of Assigns
- e ! = Spandrel Label...
Copy Aszigns —
A ST . ;;

P

The next form of Area Object Auto Mesh Option will display
Choose the marked option for mesh thin click OK

o
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Area Ubject Auto Mesh Optio

o Mesh at Beams andWals i Membrane - No Aulo Mesh f Shella Plate]

Stiffness -No Vertical Lnadéﬁansfer]

The same
choice as in
wall meshing

Assign of the diaphragm:

We have 2 types of Diaphragm

i. Rigid Diaphragm

ii. Semi Rigid diaphragm
Rigid Diaphragm Constraint causes all of its constrained joints to
move together as planar diaphragm that is rigid against membrane
deformation. And used for define the wind load

Semi Diaphragm used mainly for defines the wind load and give the
building the ability to behave as its actual behavior (Recommended)
(not available in Etabs Ver. 8)

e Choose the whole building by click in 4 button
e Click the Assign menu —» Shell/Area —»
Diaphragms...

snin

W G b Niiaiabihibitedbi i

e oty of honkgrs w gL
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e The next form of Assign Diaphrag Will be displayed

#ssien Diaphragn

¢ Choose D1 thin Click Modify /show Diaphragm,
highlight Semi Rigid thin click OK

Diaph raém Data

* Step 5: Define Static Load Cases and assign the loads

The static loads acting on the building used in this
example consist of

e Dead Loads

e [ive Loads

e FBarthquake Loads
[ ]

Wind Loads

49
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e Define of Earthquake Load

1. Click the Define menu —p Define Statié Load Cases

Or Define Static Load Cases button %+ which will
Display Define Static Load Case Names Form

rLoads : = Chek To- :
' ~ Self weight futo P
Load Type Hultipher Lateral Load pddMewlosd 1

W i al Bl Modiplosd | |

2. to define the earthquake case of loading
o Click in the edit box for the Load column.

o Type the name of the new load, in this case type
EQx.

o Select from the Type pull down menu, in this case,
select quack.

o Make sure the self weight Multiplier 1s zero,

o Use the Auto lateral load pull down menu to select
UBC97, with this option selected, ETABS will
automatically apply static earthquake load based on
the 1997 UBC code requirement.

(o

TRUNG TAM PAO TAO XAY DUNG VIETCONS Vi ETCON S
WWW.Vietcons_edu_vn ALWAYS BESIDE YOUR SUCCESS



HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

o Click Add New Load button
3. with the EQx load highlighted, click the Modify Lateral
Load button ,this will bring up the 1997 UBC Seismic

+ Divsction and Exoentiicity ‘ “Seismic Cosflicients
& W D % D

W D+ ExeenY 0 Dir+ Ecoen
K DicsEoen™ 00 DirdEdcen

: ™ User Defined
P
- 5ol Profile Type jsc ) xl

Seizmic one Factor 30-40 finsi |

J

«Tirae Period— - Mear Source Fachor

2 Method A by % & PerCode " HeerDefined

= g = jioes i E

@ Pogem Cale Lt =0 X Seismic Source Type™ 1B =
£ User Defined- Ped : Dist to Sowse (kw15

¢ rSto Range =
Top Stowy §STDH”V4U - g
Battom Stosy E - 5

| Faciors - i rDther Factors—
. Oweistiergth Factor, B 85 : Impeitarce Eactor | a1

ok ] Caricel 3/

4. from this form you can adjust the data of the code for
example you can change it as in the next form in zone 2A

according to UBC97, thin OK
: C Seis

rDirection and Ecrentricity | aric Cosfficient i : |
: } 1

X Di Y D U PerCods . U UserDefined |
& X D+ Ecoeny 77 Y D+ Eceen® "

o Soll Profile Type

¥ Dir- EcoenY N D -Eocent

. L Seismic Zone Factor
Ecoenticity Fatio 005
Oweride E cosntinties Overiide.. | ¢

‘T&me Period - —
7+ Hethod & Cy{fty= §0.02

ALWAYS BESIDE YOUR SUCCESS

" Program Cale ,‘w
———
7 User Defined ! i
Story Fangs
Tap Ston |STORY4D » 1
ey |
Bottom Stom 1BASE >
Facloﬁi S S - S — e Dthe{ Faf:il}ri 8t
Chmrsength Facio, B ’55 mporancs Factor | ,f{' ——
§ 4
o Cancel |
=t
-
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5. for earthquake in the next direction repeat the same steps
but in 1997 UBC Seismic Loading form modify the
direction to Y direction + Eccen X

e Define of the Wind Lead

1. To define the earthquake case of loading
e Click in the edit box for the Load column. Type the
name of the new load, in this case type WINDX.
e Select from the Type pull down menu, in this case,
select WIND.
o Make sure the self weight Multiplier is zero,
e Use the lateral load pull down menu to select ASCE
7.02 with this option selected, ETABS will
automatically apply static wind load based on the
ASCE 7-02 code requirement.
¢ Click Add New Load button
7. with the WINDX load highlighted, click the Modify Lateral
Load button ,this will bring up the 1997 UBC Seismic
Loading form

ASCE 7-07 Wind Loading
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ET. ABS PROGRAM

3. from this form you can adjust the data of the code according
to your area ,to show the diaphragm Data Click Modify

/Show Exposure Width, thin click OK |

Wind Exposure Width Data

AECHFLOOF
STORY22
STORY21

ST AR

O] Cal;ulate from Diaphragm E xtents
O User Defined

ok ] LC ancel ]

Repeat the same steps for wind Y and don’t forget to change the

direction of the wind

Sind Dosfhictent:

Exposure from € vterits of Rigid Chaphragms wind Speed [mph

Tl Erprsurs fior Frame and fres . -
: Laposure Tyne

inpanance

Mot/ S e Supnsors idie

Ewxpours Heght

Top Ston
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The Static Load case Names Should now Appear as in the next form

Dk Tar
 [[hddVewload |

Sefweight  Auto
tultipher Lateral Load

ModifyLoad |

y \UBC a7
O I |UBC 7
WIND /IND | |ASCE 7-02 DeleteLoad |
CWINDY LWIND |BSCE 702

e Assign Dead &Live Load to the model

e Choose the slab by click by mouse on the slab in plan
view '

e Click the Assign menu "~ Shell/Area Loads — .
Uniform..... :

Assign

L8
]
_ Tremaine o — S
| Shellfdrea Loads ﬂ;ﬁ:z Uriform... |
3 i e !
YO Group Hemes. .. FD Temperature. .. i
e yind Pressure Coeffident... i
R Clear Display of Assigns ;

i

e The next form of Uniform Surface Loads Will be displayed
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Drrection LG

ravity

Delete ExisingLoads. [0

WMDY

From the Load Case Name pull down box choose Dead Load
for typical floors the Uniform Load Value =5.5 KN/m

for Mechanical floors the Uniform Load Value=1 KN/m’
click OK |

choose the slab again from the plan and repeat the assigning to
the Live Load

From the Load Case Name pull down box choose Live Load
for typical floors the Uniform Load Value =2.0 KN/m'

for Mechanical floors the Uniform Load Value=10 KN/m

Step 6: Assign of Pier and Spandrel Labels

Choose the wall which you want to assign the pier label for it

Click the Assign menu—— Shell— Pier Label ,thin

the next form will be displayed, from this form add pier name
thin click Add New Name Thin OK
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Pier HNames

wmm

e Repeat the same steps for all walls

All the walls must have different pier name
e Choose the Spandrel beam which you want to assign the
Spandrel label for it '

e Click the Assign menu ——» Frame/ line —» Spandrel
Label the next form will be displayed from this form
» add Spandrel name (S1)
» thin click Add New Name button
= Thin OK button

spandre[ Names I——

“wiall & pandrels ~Chick, g
INONE fudd New Hame |
INONE
E{ancel |
I Mulbiztony
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

After you finish assigning the walls label and spandrel beams labels,
the labels will display on the plan as in the figure

lan View - STORY 11 - Elevation 38.2 Wall Spar

e Step 7: Define the mass source & AutoLine constraints
& Assign the supports

Assign of the Auto Line Constrain
¢ Choose the whole building
e Click the Assign menu — Shell/Area — Auto
Line Constraint...

57

TRUNG TAM DAO TAO XAY DUNG VIETCONS VIETCON S,
www.vietcons.edu.vn ‘ ’ ALWAYS BESIDE YOUR SUCCESS



_chapter1 1

Assign
IontFoint
 Framefire b

e The next form of Auto Line Constraint options Will display
Choose create line constraints around (Walls and Ramps,
Floors) thin click Ok

uto Line Constraint ﬁpti@ns

Define the mass source

e Click the Define menu » Mass Source ,thin the next
form will be displayed
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Dietine Mass Source

e From the previous form highlight From Loads from Mass
Definition Box |

e Thin adjust the value of dead load multiplier to be equal 1

e And the live load you have the choice to make it equal to
.25 or less (according to UBC code if the live load more
than 5 KN/m’ take the live load multiplier =0.25), thin the
form will be as in the next fig.

Lump Létéfa( &) aés 8t Story Lévels
- E 114 5{ ‘ ~ Cancel V
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Chapter 1 . ,

Assign the supports.

e click set plan view button

o Select all the point in the Base plan by window.

«

e Click the Assign menu— Joint /Point
Restraints ,thin the next form will be displayed

Click here to
assign fixed
support
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e Click Fixed support Icon
e (lick OK

e Step8: Check the model & Run the Analysis

e To check you model before run the analysis, Click the Analyze
menu _____y, Check Model command

e Check the all check boxes to allow the program to check all the
checks of your model

o After the program check your mode ,if there are no warning the

program display no warning if any problem in your model the
program will display warning massage to adjust your model
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@% Warning

| Modlel has been checked, No warning messages

e if you want the program fix any problem in the model
automatically ,choose the all model thin click the Analyze
menu —p Check Model command ,and you will find the
check box for selected object only is active , check this box and
if the program find any errors the program will display massage
to show to you how it can be solved

Warning for merge

e After you check your model Click the Analyze menu—-—
RUN Analysis command or the Run Analysis button o
e The program will create the analysis model from your object-based
ETABS model after the program finish the run the model will be

Jocked and display the deformed shape of the building

N
AN
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

.....................................................................................................................
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Step 1: automatic case of loading creation

o Click the Define — Add Default Load Combaos. ..
thin Design Combination form as shown in fig will be
displayed.

P Design i’_jumbir;ﬁtiﬂns

- #dd/Updiate Default Combinations —————
I~ e g e
™ Concrets Frams Dkesign e I

™ Composite Beam Design.

{7 Concete Shearwall Design

I Corverttaliser Ec‘rﬁbinatinm- [Editable]

ok | Cancel |

o From this from we will choose the load combination
code which we was defined before in chapter 1 step 2
(ACI — 318 02), highlight concrete frame design and
concrete shear wall design and convert to User
Combinations(Editable) to allow you to make any
modification in the load combination according to any
special cases of design

VIETCONS

ALWAYS BESIDE YOUR SUCCESS

TRUNG TAM BAO TAO XAY DUNG VIETCONS
www.vietcons.edu.vn



Chapter 2

o Click the Define —®  Load Combinations; thin
Define Load Combinations form as shown in fig will be
displayed.

H‘Eﬁn? Lo | ’

load combination thin click ‘
Thin the form of load combmatlon data will be

displayed

: Ease Name ,
‘QDEﬁ.D Static Load = i[14
| DEAD Static Load: 114
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

|

e Step 2: tabular Display of the analysis result

In this step, we will review the most important data coming
from the model like,

1. Base Shear of the building

2. inter story drift

3. straining actions of the frame elements in tabular form

4. straining actions of the walls elements in tabular form
The most important tabular review for the result is the summery repoft
which gives to you the most important data for the model and the
calculation details for wind, and earthquake loads, and the summary
for the result

1. Summary Report

o Click the File — Print Table —» Summary
Report, thin the form as shown in fig will be Displayed.
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Chapter2 .

e Click Fflename. to choose the location where the file will be
saved using the next form

ypen File for 'ﬁﬁnﬁ'ng Tables

g

{example 1

| Text Files {76}

4

e The next form will show to you extract of some information in
summary report (Earthquake calculation)

A

hs)

5

f;e
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

1 i ‘
| Fie Bt Format View Felp

AUTO SEISMIC INPUT DATA i

Direction: X + Eccy
Typical Eccentricity = 5%
Eccentricity overrides: No

Period Calculation: program calculated
Ct = 0.02 (in feet units)

Top 5tory: STORY40
Bottom Story: BASE

R=575

I=1

hn = 137.400 (Building Height)
5011 profile Type = sC
Z=10.15

Ca = 0.1800

v = 0.2500

AUTO SEISMIC CALCULATION FORMULAS

Ta =t (hna(3/4))

If Z >= 0.35 {Zone 4) then: If Tetabs <= 1.30 Ta then T = Tetabs, else T = Ta
If Z < 0.35 {zZone 1, 2 or 3) then: If Tetabs <= 1.40 Ta then T = Tetabs, else T = Ta
V=(vIW/RT (Egn. 1)
Ve=2.5CIW/R 4 (Egqn. 2)
Vr>=0.11Ca1Iw (Eqn. 3)

If T <= 0.7 sec, then Ft = 0
If 7> 0.7 sec, then Ft = 0.07 TV <= 0.25 v

AUTO SEISMIC CALCULATION RESULTS
Ta = 1.9566 sec

T Used = 2.7393 sec
W Used = 499320.21

v (Egn 1) = 0.0166w
v (Egn 2) = 0.08184
v {Egn 3) = 0.0198y
v {Egn 4) = 0.034%

V Used = 0,0198% = 9886, 54
Ft Used = 1895.74

AUTO SEISMIC STORY FORCES

STORY FX FY FZ MX MY Mz
STORY40 1866.33 0.00 0.00 0.000 0.000  -1376.430
STORY39 306,18 0.00 0.00 0.000 0. 000 -489, 882

/]

You can see from the previous form the whole steps the program do to
calculate the seismic force and the values of the force acting in each
floor in details ,also the program give to you the details for the wind
calculation , summary of the input data .and the results
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2. Tables Display

o Click the Display — Show Tabels
o thin the form as shown in fig will be displayed.

C‘nms«e Tables for Display

=¥m] MODEL DEFINITION {0 of 86 tables selected)
E?»D Building D.ata
& Property D efinitions
%1 Load Definitions
&[] Point Assignments
#-[] Frame Assignments
&[] Area Assignments
#[]] Design Ovemwrites
&[] Options/Preferences Data
& [ Miscellaneous Data
ANALYSIS RESULTS {0 of 15 tables selected]
[7 Displacements
[} Reactions
# [0 Modal Information
2Ll Building Dutput
{1 Frame Output.

o From previous form choose and mark the data which
you want to display ,and the case of loading thin click
OK

o As an example , mark Reactions ,and select Dead, and
EQX case of loading, thin click Ok
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABé PROGRAM

= {0 MODEL DEFINITION {0 of 66 tables selected) ; :
&[] Building Data
i ® [ Property D efinitions
. & [1 Load Definitions
:E[:l Point Assignments
#-[] Frame Assignments
E‘ED Area Assignments
#[] Design Overwiites
#-[1 Options/Preferences Data
#-[ Miscellaneous Data
ANALYSIS RESULTS (1 of 15 ta
@[] Displacements
# @ Reactions
#%-[1 Modal Information

& [ Building Qutput : L /- . e
% [] Frame Cutput h . e - :
Carcel 1 3 :

Hamed Sefs s *

Saved Mamed Set.. 3

i

L Cleardl |

'EGY Static Load
LIYE Static Load

~UDCONTS Combo ~ :
s Clearall |

o The next form of the reaction of the supports will be
displayed |

Edit- yiew

A

L4 >
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C’haptér’z

Y ou will find in the end of the form the summation of the reactions
e Step 3: Graphically Display of the analysis result
In this step, we will review the result coming from the model in
Graphical Display, this result like

1. Reactions.
2. Beams and columns straining actions.
3. Walls &Spandrel straining actions.

1. Reactions: to display reaction click on the plan view window

to activate it ,and click on set plan view button  pja ,thin from
plan level form choose base level thin click OK

Select Plan Level . |

ASTORYY

1STORYS . | e
STORYS o L e
STORY4 . wwwﬂEij
ASTORY3 VE et .
(GROUND

Thin the plan view of the base level will be displayed, click Display
— " Show Member Forces/Stress Diagram * Support
/Springs Reactions... -

Dispiay

it o -
Shall Sirssces Foroe
Shell SyessesfForces,,

Or
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

"The Point Reaction Force form will displayed, thin choose the case of
loading

Load

7% Heactions 7 Sping Forces

HAGCOHT Combo
UDCOM2 Combn o

LR £ {0 wek |

Carcel | i G

o

AT [ M

AT G SRR tig
:

£ AU,

3
il o o
= = Gl i
i e

*
.ég.
¥
st 5 0 0agk At arbasi ¥
¢ i e
F g " W 3

b
£

1 ”
- & g = #
b
i ik Pty i 14
g ! E P 5
= ( ; =
P
= =7
. pif e
b B
‘ e d i
J’ s ,gﬁ i ki
E E
3

i

.
a,.
4

&
¥, i IRRIH,
1%

Eon

N

=
{22
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To display the value of any point reaction, choose this point by click
on the left button of the mouse and thin click on the right button of the
mouse, thin the restraints reaction values will be displayed as shown
in the fig.

Point Obisct 58 Stowlevel BASE

: 1 w2 3
Force 1712.429 -2.619 4107450
Moment 0.000 0.000 ~ 0.000

2. Beams & Columns Straining actions: to display Straining
actions(normal force , shear force ,moments ,and torsion) click
on the 3D view window to activate it and click on set Elevation
view button = thin from Elevation level form choose (I) thin
click OK (you can choose any another elevation ,this elevation
as example only)

:izdd Hew Elevation.. k

i

P cidify/S hiows Elevation. .

Delete Elevation Hams §

T o Mmoo m w3

’ { K, i s Cance!i

Thin the Elevation view will be displayed,
Click Display—— Show Member Forces/Stress Diagram ——p
Frame/Pier/spandrel Forces
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

1 Show Undeformed Shape

7 Shov:' Deformed Shape...
£ show Mode Shape..,
figilShow Member Forces/Stress Diagram | »

7/ Shiowe ﬁnergy{'ﬁ;‘irhal Work Diagram. ..

Support/Spring Reactions. ..
E_ran;&jpier,’Spandrel Forces..,
Shell StressesForces...

SupportfSpring Reactions..
| Frame/Pier/Spandrel’

Shell StressesfForces...

Show Stery Response Plots...

The Member Force Diagram for Frames form will displayed,
choosc the case of loading

[ mwzu‘lay‘ne‘ Sheas £  ‘%hpl‘anef,mﬁmertt

- Scaling

™ ScaleFactor

= Include : :
W Frames T Piers [~ Spandrels

H
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i

B Y

Click the OK button to generate the Member Force diagram for
frames

To see the moment values click Display ——» Show Member
Forces/Stress Diagram — Frame/Pier/spandrel Forces

e Uncheck the fill Diagram

e (Check the show Values on Diagram check box

e Click Ok thin the diagram will be shown as in the next fig

P iiation Vo o8, - bormie %) gty 0ERDY. 20
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Left click on the beam by the mouse thin right click to display the
form to bring up the Diagram for Beam form

iagrdin for Beam:B26 at Story STORY29 (B40X90) .

Moment 143
A01.523

The maximum values for applied load, shear, moment, and deflections
are identified on the diagram, if you want to know the value at any
station of the beam click the Scroll for Values option and a scroll bar

appears at the bottom of the form, you can drag the scrollbar by the
mouse to see the different values at different locations
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Chapter 2

Diagrap for Beam B2

e To use
r“‘;’ﬁ,f;"':*,/ scroll

To see the

S i max.
Shear vz Values

0

b Hioment b3
]

y Dieflection [Down +
b 12HEDS

s i

‘4/"; ‘ ’ ¥ 1 Lacation ‘_«-.._ TR
Scroll s - , : Urits JEHm 3]

T

3. Walls & Spandrel Straining actions: to display Straining
actions(normal force , shear force ,moments ,and torsion) for
the walls and spandrel beams

o repeat the same steps as in point 2
o click on the check box of piers& Spandrels

-

- Componetit
1 fial Foree T Torsion
T Shesr 22 ™ Moment 2

22
£~ Shear 3-3 & - Mament 33

(!

S Sﬁaﬁng
A huto

£ Scale Fééirjf 2

- Uptions

iV Fill Diagram
o Shn

T inchide : -
v Frames W Pies o B ‘Epaﬂdf&@

wie
/o
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

155 Y P R I O

% el

)

£y

4

y

WalLFER 0 P2
Story Level Bl

BOTTOM ‘ TOF
distance ;1 75 ~waiue 1516211

Move cursor over diagram for values

e 79
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Concrete Frame Design(beams &columns)

1. Adjust the design code and Data of Design

]
e C(Click the Option menu — Preferences ——
Concrete Frame Design
Oiptions
Dimensions;T dlerances. ..
Colors : ‘ Cutput Dedmalz. .
Windows v otes ol Frame Diesign
Set Calodator Memory . = B
= Composite Beam Design....
: Show Tips at Startup ~ Shear Wall Design...
« Showe Boundin:
Stow ﬁmfjﬂd@g Plane e 0 Fipmﬁ"rrement Bar Siges, ..
' '+ MomentDiagrams on Tension Side ~~ Live L;:sad Fi&dur:hn_ o

This will Display the Concrete Frame Design Preference form  as
shown in fig.

Design Code

a‘ldj a0 %

Ervelopes
. Humbe; of !nterdttxan Comez 24 k\ Seismic Design
Murmber of Interaction Points 11 category,adiisted
| Conzider Mirimurn Eccentricity Tes according to the area
E'hi [Terzion Cortrolled] L 09 of the progct
Phi{Compressior Controlled Tied] .65
Phi{Cormpression Contiolled Spirall - 07
Phi[ahear anddor Torsion) 0.75
. {PhifShearSetsmic) | 0
(PhifSheatdong 085
Pattern Live load Factar -0 075 ‘ i = ——
Utiization Factor Lirrfi’t“ £ e 035 V\\ Additional factor of safety
- ‘ dLs s ihe program use 95%f

ncrete section

£
gl
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Chapter3

From this form, you can adjust the code and another data of design as

shown in pervious figure.
2. select of the Load of Combinations

e Click the Design menu —» Concrete Frame Design —»
Select Design Combo

T Composite BeamDesign
&= Steel Joist Design
E Shear Wall Design

Esispﬁa? Desigri Info...

e Thin the next form will be displayed

Combos

- UDCONT
JubComMo
UDCOKTT
LpComtz2
LDCON13
UDCON14
o UDCONIS
L HUDCONTE
SUDCOMT
_{UDCOMNIE

{UDwsL1Z
{UDwsL13
|UDwiaL1d
UDWALTS
 UDwALTE
HUDwaL17
UDwaLTE

e After you add or remove any of the load of combination
click OK (in our example we will use the default of the

program)
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

3. Start Design

e Click the Design menu — Concrete Frame Design—#
Start Design/Check of Structure

Dizsign

I steslFrame Design
T Composite Beam Desigrs g Views Hevise Qverwrites.u
Z= steel Juist Design : 3
C shear Wall Design

Select Design Combo..

Overwrite Frame Design Procedure.,.

e All values are 0.00 because the unit which is used in program is
m, Check the units of the model in the drop-down box in the

Q7
oo

VIETCONS
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lower right-hand corner of the Etabs window , click the drop-

down box to set the units T
To KN-cm, thin the value of reinforcement w111 be Tonm
an-m
Displayed in cm o
Ti.Jh -G ~

i b :M

1. For beams the program give to you the reinforcement at
3 stations of the beam(end right,middle, and end left),but
for the columns the program give to you one value of
reinforcement
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

P78 iahation Vw1 Doniiictinat Belnaesing (e D10RY

Beam
/ Reinforcement

188 378 73
146 ¥ 334

1000
1000

Column
Reinforcement

2. To display the shear reinforcement ratio for the shear
,Click the Design menu —— Concrete Frame
Design ——p Display Design Result, thin from
the next form choose Shear Reinforcing

{6¢5] Bearn/Colurin. Capacity F atios
Colurnn/Bean Capacity B atics
Joint Shear Capacity R atios

= T orsion Reinforcing

3. Thin the ratio for shear reinforcement will be displayed
as shown in the fig.
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Chapter 3

4. To display the Torsion reinforcement ratio for the beam
.Click the Design menu ____,, Concrete Frame
Design —»

Display Design Result, thin from the next form

choose Torsion Reinforcing

'+ Design Output Torsion Renforcing

Fiebar Percentage
Shear Fenforcing
Colurmn Pk - Interaction Fatios

“lurnr Capacity Fafios
ity Fatios

T Design Tnput

furri

1
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

5. Thin the ratio for stirrups of torsion reinforcement will
be displayed above the beam and the side bares area will
be displayed under the beam as shown in the fig.

View-l. TOrﬂlbnRe'mfurcmg (ACI

/ Ratio for stirrups

0.600 0.039 0.039
£.000 16,559 16.559 {
V\ |

N Side reinforcement

area

6. To display the Concrete Beam Design Information

1. Choose the beam member by click the left button
of the mouse

2. Click the right button of the mouse

The next form of the Concrete Beam Design

Information will be displayed as in the fig.

2

AM D/ A IETCONS
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SOGTE: T SeconMame  [BA0XED

ok

ATTON

100

Bg

5.00 1.4a64
00,00 1.064
_____ 1.864

2.45%5
3.783

Lo .
Flew. Details | Shear Details |

- !
SUmEY . 1

Cheemvrites |

Caricel §

{0
0

TRUNG TAM BAO TAO XAY DUNG VIETCONS
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from this form the program display all the case of
loading and the corresponding area of steel which
is required for the section according to the design

data

7. The Concrete Beam Design Information has 4 important
icons

1. Ovewites :this icon to display the concrete Frame
Design overwrites and allow you to

e change the element section
e change the element type

e change the information for the beam
properties

VIETCONS
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Before you make any change you
must mark this cell

attor {K Minor}

| Moment Coefficient [Cm M ajor)
HMoment Coefficient | ; : :
{NonSway Momenit FactofDnsMapprd] 1.\ | Chose sway intermediate
§ NonSway Moment FactorlDins Minar] | Do or ordinary in one 2A
gSw,:y Moment FactorDs Major) ~ 1o
i

ﬂﬁﬁﬁﬂﬁﬂﬁ

Sway b oment Fac!:or[Da Mmor}

' ;wa_t,t Ir'|f.E!HT!ECliE’lt‘m:'r_w~

I"-i onS ay

3 :this icon to display the summary of the design
of the beam

1. information of the beam
2. flexure Reinforcement
3. Shear Reinforcement

4. Torsion Reinforcement

5 Click Summary the next form will be displayed
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Chapter 3

File Drawing
* Urats ‘mm/~~M —v;
AC1 348-82 BEAM SECTION DESIEN Type: Sway Intermediate Units: KN-m (Summary) ‘
Level : STORY3? L=%, 9888 ¥
Element : B26 D=0.988 B=0.4088 bf=8.488
Station Loc : 3.8886 ds=§.008 dct=8.858 deb=8.858
Section ID : BHBX9G E=28808880. 88 fo=49006. 608 Lt.4t. Fac.=1.888 5
Conmbe ID * UDLONS2 fy=460808.060 fys=u66808.0800
Phi{Bending): 0.968 ;
" Phi{Shear): 8.758 !
Phi{Seis Shear): 8.608
phi(Torsion): g8.758
pesign Homents, M3
Positive Negative special Special
Homent Homent +Homent ~oment
58.489 -175.228 58.489 -175.228
Fiexural Reinforcement for foment, M3
Required +Homent ~Homent Minimun
Rebar Rebat Rebar Rebar
Top {+2 Axis) 6. 7B6E- 64 8.6806 5.938E- 84 6. 7B6E-84
Bottom (-2 Axis) 2.22BE-8B4 1.665E-04 §.8u8 2.228E-84
Shear Reinforcement for Shear, U2
Design Shear Shear Shear Shear
Rebar Uu phixiic phixys yp
§.9688 89.253 267.838 §.088 75.395
Reinforcement for Jorsion, T
Rebar Rebar Torsisn Critical area Perimeter
At Al Tu PhixTcy fio Ph
2.981E-84 6.881 h4.118 19.633 §.214 2.24%

Units {KNm

¥

i smnv39
: 828

Level
Element -
Station Loc : 3.800
Section 1D : B4EX9H
gombo 16| < UDCONS2

B=B.400
dct=8.0858 :
_ Fc=10008. 899
500646 080

LE.Wt, Fac.=1.880

Fy h60060.080

Phi{Bending):  8.908

Phl(Sheat) 8.758
Phi(Seis Shear): 8.608
Pni(Torsion):  0.758
FLEXURAL RETNFORCEMENT FOR MDHENT, H3
Required . rvellpment -vedoment  Hinimum
Rebar Rebar Rebar Rebar
Top  (+2 Axis) 6.786E-04  6.000 5.630E-04 6.706E-04
Bottnﬂ (-2 Axis) 2. ZZBE)BH 1.665E-84 p.686 2.220E-Bh4
Design Moments Hu3 [
Design  Design Factpred  Factored Special | Special
“+uehoment -wveloment = +vehoment -~veloment “+yetioment | -veloment
59.499 -175,228 - @.088  -175.228 58480 —175.228

90

TRUNG TAM PAO TAO XAY DUNG VIETCONS
www.vietcons.edu.vn

VIETCONS

ALWAYS BESIDE YOUR SUCCESS



HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

fheaiUglal8] :this icon to display the information of the
demgn of the beam for Shear & Torsion

TRET wie-g Eum SEGTION pESTOR wpm Suby Taternediate  Uai

Lewel B U e e !

ement Ex oL bes.gBm Gopoaer . BEel e .

Station Lec 3,888 7 ds-a.pad e b-f 58 ity 858

Section 10 = , E-2000BO00.50 © (1 ~40080. 408 LML Fd‘c '1 L]
: : k)

SHERH/VORSION OESION FOR UZamg 10 |
feber | ebar Howar
e woo S Fa o
l 408 Z W’Y( L [ -2 L5 Bha: g A

| Besign Forces

. Factoved Fag:tﬁrw
[ . 1

: e
o PR BRE DR

e Important Note : after you finish the process of the design
,sometimes you change some sections of the beams and
columns to make the program reassign the frame element
again according to the designed sections ,

8. Click the Design menu — Concrete Frame
Design — Verify Analysis vs. Design Section......
,Automatically the program reassign all the frame
sections in_the next run according to the new sections of
design

T steelFrame Desigrn
R} concrete Fraive Dission
F Composﬂe ﬁeamawgn
T steel. mtﬂeszgn

[ shear waliDesgn

mteradwe Cmcrete Frame Dessgn
‘ G:sp!ay i}esm In'éo

Reset Al Concrete Overwrides. ..
Delete Concrete Design Resgdts.,.,

r 3 91
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o Shear Wall Design

e There are there method for design shear walls:

1. Simplified C and T Section

2. Uniform Reinforcing Pier Section

3. General Reinforcing Pier Section

e Simplified C and T Section :

o this method is very simple method for design ,the
simplified method can only be used for design ,not for
checking.(not recommended method)

e Uniform Reinforcing Pier Section:

o this method is the most famous method for design; this

method can be used for both design and checking.

(recommended method)

¢ General Reinforcing Pier Section :

o this method is the most accurate method for design but
it is need more efforts from the user because if you use
this method you must draw all the walls section and its
reinforcement of the all walls
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

1. Adjust the design code and Data of Design

e Click the ()ptioh menu ——p Preferences —_y Shear
Wall Design

[ Show Tips at Startup

Load T

This will Display the Wall Pier/Spandrel Design Preference form
as shown 1n fig.

 |DesignCode I YERE
-1 Time History Design = Erwelopes
Rebarlnits :
Febar/LengthUnits 2/t
A Phi{Tension Cortrolled) = 08 W

Phi [Compiession Controlled) ~ 065
Phi{Shear and/or Torsion) o 0 075
PhifShear Seismic) « © 0 0B
A PmawFactor 0. 0.8
MNumber of Curves ' 24
Murber of Poirts 11
Edge Design PT-Mayx .06
Edge Design PC-Maw = 0.04
Section Design [P-Mag i 002

Section Design IPMin s L - Cancel j

Utlization Factor Lirit

Additional factor of safety
the program use 95%f
concrete section

b

(2
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From this form, you can adjust the code and another data of design as
shown.

Wall Pier/Spandrel Design Preferences , "o
om”2

ACH31802
Ervelopes

2. select of the Load of Combinations

e Click the Design menu —p Shear Wall Design ——»
Select Design Combo

e Thin the next form will be displayed

Design Load Combinations Selection”

HUDWALT3
UDwALT4
UDwaAL15
4 HIDWwWalE
JUDwWaL1?
UDwALTE
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e After you add or remove any of the load of combinations
for design click OK |

4. Choose Method of design

e Click the Design menu—— Shear Wall Design ——»
Assign Pier Sections for Checking ——» Choose the
method of design; (choose Uniform Reinforcing Pier
Section as we mention before.)

LI
- ys_melriré‘m‘
& concrete F

 Select Design Combo..,

iew Revise Pier Overwrites

5. set the Elevation view of the wall

Note: the program display the result of design for the wall in the
elevation views so that we will display the elevation view of wall to
check the result of the design

e activate the window of 3D View

e Click the menu of View _____ Set Elevation View

Or the icon ® | Thin the next form will be displayed

Add Hew Elevation.. - o

g

|

25 3
Mordty/Show Elevation.. |
|

Delete Elevation Hams

T GO T O B L R

& C[oe 0 cancel |
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e From this form choose elevation 7 (you can choose any
elevation view, but this for our example),thin click ok
e The screen of the program will be as in the next fig.

6. Start Design
e Click the Design menu——— Shear wall Design —»

Start Design/Check of Structure

e
5 o
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

* From previous figure we see that the program display
the ratio of reinforcement required for this wall

7. To display the Shear Wall Design Information

1. Choose the Wall by click the left button of the
mouse

2. Click the right button of the mouse

3. The next form of the Wall Design Information
will be displayed as in the fig.

ng Pier Section - Design (AC1 31808

4. From this form the program display the design
result for flexural design, shear design, and
boundary element check (boundary element
check is neglected in some codes.)

97
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Chapter3

8. The Wall Design Information has 2 icons

UDCON1S

2. Owenwites :this icon to display the concrete Wall
Design overwrites and allow you to change the
design type, the reinforcement in the wall, and
change the design to check of the wall

reinforcement
oy D 0 s 0 0
I Doesign this Pler? Yes
™ {LL Reduction Factor 1.
™ 1 Desigr iz Seismic? RS
™1 Piet Section Type Wrifom Beinforcing
™ {End/Comer Bar Name 158
i {Edge BarName 154
™ {Edoe Bar Spacing 075
I A Clear Covar 1a3s
™ Materal COMCED
™ Check/Design Peinforcing [esion
Cancel i

o0
i
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

®* To make any change in the previous form you must
check the cell before the change thin begin the change to
the checked cells

Pier Design Overwrites - Uniform Reinforcing Section (ACI [Eli=llRst-lgtelier]
Simplified T and

Uniform Reirforcing
25d
20d
02
0.3

G

CONCED
Des

e If you change the data as shown ,and change design to
check the result will be displayed as percentage of the
safety for the wall(steel Demand/capacity of the section)

P Etvation ",’iexf) = F PiBe Lon: 105 5 G 36078 g@l@

T i [r——— % A regired

Check
A DemandtA capacity

29
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- Chapter 3

e After you make check repeat step 7 again to see check

the result form

F!exural Check for P- M2 M3 :

DJC. Flexural
.~ Combo
ooDwaln
o oDwible

Stations :
‘Location. ©
s

o Bottom:

ShearDesign

Station.
Location
Toplegt
BetLeg ‘l

Boundary Element Check
‘v Gation B-Zone
Length

1118

o128

Locabion
Top Legd
Botlégd.

0‘381 :

: iSh'eaxy

Combo

S DWALE
DaLs

“ B-Zone

Combo

Drw/dlg:
o DALE

o Pu
nmey
33805510

24504 G5

24914160

Pul
33753134

34162.694

“pu e

; H3‘u‘
<-405.489

Mu
noog
0o

e

, Mo va
1313240 2064598

22084.552

Mu “yu
11845567 590 942
14361417 R98.942

18605211
: Caﬁéci'ty .

2064598

Capacity
phiYn
2803725
2803125

phiVe
0000
o0

100

e We can notice the difference in flexure check the
program display D/C Ratio not the steel required

9. To display the Spandrel beam reinforcement ,Click the

Design menu —— Shear Wall Design
—» Display Design Info..., thin from the next

form choose Spandrel Longitudinal Reinforcing

[Gereral/Uniform Pier Reinforcing Ra
N Gerneral/Uniform Pier 0/ B atios

| Simple Pier Longitudinal Reinforcing
‘ e Pier Edoe M emhers
.dr‘el'l;ijr '

& . g .
i p.andrel Uiagonal Shear Reinforcing
Fier Boundam Zones
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e The result of the spandrel reinforcement will be
displayed

10. To display the Spandrel Beam Design Information

1. Choose the beam member by click the left button
of the mouse

2. Click the right button of the mouse

3. The next form of the Concrete S. Beam Design
Information will be displayed as in the fig.

SN
.
Y
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Spandral Design

e /As we explained before you can change the data for the
design using Overwrites icon which is displayed in the
spandrel Design Overwrites form

)

pandrel Design Overwrites (ACI 318-02

i , n Bigh
4CoverTopBight
151k Width Righ

1 SlabDepth Righ
Material
Conuder Ve?

T o o e e e

gmw,h

0

TRUNG TAM PAO TAO XAY DUNG VIETCONS Vi ETCON S
WWW.Vietcons_edu_vn ALWAYS BESIDE YOUR SUCCESS



HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM
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R N TR R T )
R R R R N R R NN T
R T R Ty P S TR R R )
L R R N Ry N RN RN
O T N  E  E F F R Ry TR
R S R T T N T N RN T N
R L LR
R R O R N T T T N
R R R R R NN R PN RN YR TR
R R R R I R N RN R N T
R Y RN P PR
L R Y N
R R R N Y
R N N R R N N R P N NN N NS NN
R R P
N P N R R Y A T TRy
R R R R P L]
N N N R R R L L R EE E T N F N T
O R N R T E Y YRR T T
T N N
R N R R R R R P NN T
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Steel Design

Chapter
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Steel Design:

+ 1. Adjust the design code and Data of Design

e (lick the Option menu —® Preferences ——»Steel
Frame Design

il SR Dimensions Tolerances. ..
Colors ) L ‘Qutput Decimals...

Windows

Set Calala tor Memory...

v Show Tips at Startup

Show Bounding Plane

|v Moment Diagrams on Tension Side

This will Display the Steel Frame Design Preference form as shown
in fig.

i Design Code &lSC-LRFBEE
TimeHigtorp Design . Erveelopes
FrameTppe = 0 0o dMoment Frame
Consider Deflection? , ez
Deflecton Check T ype Both
DL Limit, L7 120 ) DLEFD f:if:i
Super DL+LL Limit, L/ 120 AI5C-LRFDAES
Live Load Limit, L/ 260, UBCA7-&5D
Total Limit, L¢ 240, UECST-LRFD
Total-Camber Limit, L/ 240, B5ESE0 50
DL Limit, abs 0.0254 BES5350 2000 ~
Super DL+LL Limit, abe 0.0254 L
Live Load Limit, abs IR IPT:
Total Limit, abs .
Total-Carmber Limit, abs Cancel
Pattern Live Load Factor o
Stress Rabie Linit
b amimur Auto lteration 1
105
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_Chapter4

1. From this form, you can adjust the code and another data of
design as shown in pervious figure.

2. From the Design Code drop-down list choose AISC-ASDO1
Code or any another Code you want your design based in.

2. Define an Auto Select Section List

e The program has several built-in auto select section lists,
and you can add in built up section to create an auto select
section.

e Click the Define menu————— Frame Sections
command, which will display the Define Frame Properties
form shown in the next Figure.

~ Properiies - Chck, to

Tupe i property bo firsd:

%%n‘z;n:mt 1 Mwdide Flange _::j

é.ﬂ"ﬁ.s:id Fowdide Flange "f"i

A-GravBm o
AGravCol v -
& L atEm Modifu/Shoef Property.. L

A-LatCol

S Tilhedw10 Diglete/FProperty
A-TiChdw 1z : /
A-TrThekat4

O-Tiadebl
1A-Tieek1

& Thelebd 2 v

i

s

Cancel

18dd 1Awfide Flangs I

Add Pipe #
Add Fectangular o

w:sd £ rm[:‘n:nuhf

3. From the Shown drop-down list choose Add Auto Select List
thin the next figure of Auto Select Section Form.

o g e
[ gm
[

b S
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

1

Click this button to add the sections from the list
of the sections

A Seléétian “Steuti;én'sg .

A

 Auto Section H%e i f‘«U-TDJ

Add here
the list of
the
sections
which the
program
will use in
design

-~ ListatSections Auto Selections
w13 .
The all whis
available -
section of i
the program | ey
(built in | b TR
section and | rSt&ti{'&gSgcﬁon : : : :
the section | | e - dveits
you defined
to the
program
Click this button to remove any section
from Auto Selections List
2-Click P!\dd button
A
1-select

~Stating Sechon

§ tedian Cvenaite 3§

B‘Ciiﬂk OK butt )ﬂ /v 0K, % Cancel 3
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3. Assign the Auto Frame section to the modal
» Select the frame elements using the window selection
e Click the Assign menu . Frame /Line — p

Frame Section, thin the Assign Frame Properties Form will
be displayed as shown

e Select Autol section thin click OK
4. complete of the modal creation

e Complete the creation of the modal as we explain before
thin Run the analysis.

e In the initial analysis ,the program used the medium section
by weight from the Auto Select Section List

5. select of the Load of Combinations

¢ Click the Design menu———> Steel Frame Design ——p
Select Design Combo

Note: As we mentioned before the program create automatically
the load of combinations according to the design code ,and
allow you from this from to remove or add any case of

; ——%
L
o0
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

loading according to the design process, in this example we
will use the load of combination which the program create .

e After you add or remm}e any of the load of combination
click OK

6. Start Design
Note: When an auto select selection list is assigned to a frame
member, the program can automatically select the most economical,
adequate section from the auto select section list when it is designing

the member.

e click the Design menu —® Steel Frame Design
— Start Design/Check of Structure

e After the program finish the run the next form will
displayed

Analvsiz and design sections differ for 568 steel frames, Do vou want fo reiterate analysis and design?

|

Click Yes to reanalysis again with the new sections which
coming from the design

e After the program redesign the all sections according to the
design sections the previous massage will be displayed
again mentioning the no. of difference between design
sections and analysis sections

\
, ) ‘ , ' _ o ) . i

¢ ‘\\’1 Analysis and design sections differ for 257 steel frames. Do you want to reiterate analysis and design?

A

|
i
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Chapter 4

P eyoatian iowi» B Shotd i ol e AT ¢
3 2 i3 4
o o -y o
. STOHEYY
WKL YWEBX15 WISKEL
Ed z 8 8
* x® P x
w0 p=4 154 ™
> Lol i- -
= z 1= =
,,,,,,, _BIORYY
WEX 18 WEXAS WEX IS
w ® & -
2 £ = 5
] & £ E
E z z z
— BIORYE
WaxXzY WHXTE WEXE
e 8 g &
i = =3 ¥
i = ¥ %
4 z b z
Lk O Roiiecis
WK W22 WAOKZE
) 3 H g
2% iz e &
. ¢ BASE
& Y & ¥

e repeat the previous steps until the analysis and design
sections are the same and the next message will be
displayed

siress/capadty medm |

.....

Important Note:
1- Some times it is take too much time to make the analysis and
design sections the same and it is up to you to take last design
sections or to complete until the analysis and design section be
the same
2- If some sections not pass the stress capacity check, this mean
you need to add larger section to the auto select list
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e select all the members thin click Design ¥ Steel
Frame Design —» Make Auto Selection Null ,thin the
next form will be displayed

#  Confirm turning -off Auto Select Section Assignments and accepting current design sections for selected steel frames, |

Mext ana?ysisw’rﬁ use current design sections,

_ Cancel g

e Click OK button to remove the Auto Select Section List
and Replace it with the Design sections which is mean
every element reassign again according to the design
Sections.

7. Review the Result of Design

1. Right click on one of the Steel Elements the program will
display the Review form, you can click of any of the icon of
this form to make any change in design data or to check any
of the results data

Stary STORYS dpalyziz Section fn e

B eanm §B 5 Dlesign Section Jad 1850

¢/ -¥RT-5HR-—-¥IN-SHE-/

T T e

s

= Po0LO00 4 o.00% 0.00n0
= Lo 0,00 4 O, 000 0,000 0, G0n
= £ 0,000 + 0L 000 0,000
= 0.000 4+ 0.000 0,001 0,000
= 0,000 + 0,001 + 0.000 0,000 0,000
Ovenyrites Dietals
R -
Ok | Carne
<
LI
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Story ET0RYZ

Analysis Section  JWIBKED

=

Shength

{7 Deflection

_VOMENT INTERACTION CHECK-———-/,

‘ D02+ A
o = 0,000 + 0,001 + ! 0,000
3\ I 34.00 OG22 = 0.000 4+ 0,000 + 0.000 0.001 0,000
%i» 31 54.00 G.00140) = 0.000 4+ 2,000 + 0,000 g.0048 0,000
1D5TLEL 47.9% 0.0004¢C) = 0,000 + 0,000 + 0,000 0.000 0.a0n
% 31 EL1.80 0.000{2) = 0,000 + 0.000 + 0.000 0,001 0.000
i 32 3.88 0.002{C) = 0.000 + 0.001 + 0.000 0.o0no G.on0

Ovenarites ;

Design Section. ~ [W18a0

; —MAT-SHB- - -MIN-5HB~/
: ERATIO

Retails

Canc %

o T mseusiies SIEEL SUION GHEDR - ety

7 Dot Deson Sechon - 0 AR i?:fim";,“;’” fﬂ.’?’»’?@,“.éﬁfz’?ﬁi{“
M Element Tupe i M £ a5 .
o Boh] o ot Lo e e
H DL Limit B 12 SR fyrhE R
I~ Toupe DAL Ly L p R - :
’r‘“ Ll’\“fﬁ LGE!d le!i,L 7 %B F R Bt tapanity Ratie 89 BB - 0.8ED o+ RoMEY - 9 NS
1‘" Totaltimt £ DAL AHRERE CMERKM FORREE 4 a&;:t*‘;f« s i " v
7 i Tola-Carbet Limit L7 240 vavgs | 9EILEY ol A FpR ey . X3 B
T DL Uit abg g 1) enie vosiE S RISAEL MPEMP BENISN (8524
T Super BLALL Limi, ab 1 R ol i
7 Vhive Load Link abe ¥ wdel LEZ2Y LA -] ELIE S
7 I Totahbiret, abs 1 e peinite Ba # 87 % H
™} Tobak-Eaunber Limit;abs % Wgar boking T o R A AR G ¢
™ ISpecified Camber 1 Fhmey erstiog GBEE . APIRER LA 7oA SR LA RonT
4 Live Load Fleduction Faoter by eReR BRI - I
™/ Unbraped Length FratioMajor) D44ty ) Horer Batin
I [ Uirared Length PdliofMings, LT8] EETT: S o 44 S
™ TEtaniivs Length Fachar [ Major] B
™7 { Etfective Length Faciod i Miner} T
7 I Moment Costfi {Coiv Major} Rias]
7 L Moment Dosfhicient [y Miner} DS
7™ 3 Beeding Coelficient [T} 1
T™ i ManSway Moment Fanior {871 bajor} 1
T NonSway Moment Factorn (B Minar) 1.
I™ 1 Sweay Moment Factor (82 Major] 1
T3 Sy Moment Factor [B2 Mingr) 1
I 5 Yield shess, Fy. o
7% Compressive Capaciy, ghiFrg 13
T | Teraie Capacity; phiPnt f,
7 1 Major Bending Capacity, phithind il
{7 “FMiror Bending Capacity_phitdn2 .
7 PMaor Shear Capaciy, phiting o
I Minor Shear Capacty, phivind 0

o
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Composite Beams Design:

1. Adjust the design code and Data of Design

e Click the Option menu —» Preferences —»
Composite Beam Design

‘Qpﬁéns

{
i
i
i

Windows

St Calculator Memory...

:Edman: Diaéra g

This will Display the Composite Beam Design Preference form as
shown in fig.

Studincrease Factor )
Additiorial Minimurn Shuds d

AISCLRFDSE  w!

R
AISCA5D59

) ut § PR b
4 || BsEEnan
oot Teb | I Indian i5:800-1350

DesignCode  |AISCLRFDOZ ’; :
Fesat 4l ; 0K g Cancel ;
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_ Chapter 5

e From this form, you can adjust the code and another data of
design as shown in pervious figure.

e From the Design Code drop-down list chooqe AISC-ASDO1
Code or any another Code you want your design based 1n.

2. Define an Auto Select Section List

e The same steps as we explain in steel frame design

3. Assign the Auto Frame section to the modal

e Select the frame elements using the window selection

e Click the Assign menu — . Frame /Line —
Frame Section thin the Assign Frame Properties Form
will be displayed as shown

- Properties : ~Click tee

T“pe it1 property to find:
lsuTo
A-Trelebl2

A-Tiw ebHE50
ﬁ' va‘v ebHS5r

§lmport j5afide Flange _Lg

|8dd1fwide Flange 7|

Modifp/Show Property. . §

Delete Property §

e Select Autol section thin click OK

4. complete of the modal creation

e Complete the creation of the modal as we explain before
thin Run the analysis.

<

ERRRY
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e In the initial analysis ,the program used the medium section
by weight from the Auto Select Section List

Note: the default design procedure to secondary beams is composite
beam design

5. select of the Load of Combinations

¢ Click the Design menu ——® Composite Beam
Design  —»  Select Design Combo

Note: As we mentioned before the program create automatically
the load of combinations according to the design code ,and allow
you from this from to remove or add any case of loading according
to the design process, in this example we will use the load of
combination which the program create .

e After you add or remove any of the load of combination
click OK

6. Start Design

Note: When an auto select selection list is assigned to a frame
member, the program can automatically select the most economical,
adequate section from the auto select section list when it is designing
the member.

e For Design of Composite beams you have 2 choices :

1. Design Using similarity : this method make the program design
all section and select the large section for all

ﬂ dg' A 7
G | 11/
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2. Design without similarity : this method make the program
design all section and select the optimum beam size from the
auto select list

Note: for the both method we can do the same step of design, we will
explain Design without similarity method as example for both
methods.

e Click the Design menu —» Composite Beam
Design —— Start Design/Check of Structure

o After the program finish the run the Result of the design of
the section will be displayed in the 3D view as Shown in the
next Figure.

0
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

HaHH

e As we mention before in steel frame design the design
sections differs from the analysis sections. we will do the
same steps as we ao in steel frame design to be sure of the
design sections is the same ad the analysis sections

¢ Click Design menu—* Composite Beam Design—.
Verify Analysis Design Sections, thin the next massage
will be displayed mentioning the no. of difference between
design sections and analysis sections

B Arnalysis and desion sections differ for 108 composite beams, Do vou want to select them?

v
{'D
T R S
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, Chapter 5

e C(Click Yes

e Rerun the analysis again and the program will take the design
section as analysis sections ,Click Run Button | ,

e Repeat the previous step of design unit the program display the
next form

Analysis and design sections match for all composite beams.

Important Note: we mentioned before in steel design
1- Some times it is take too much time to make the analysis and
design sections are the same and it is up to you to take last
design sections or to complete until the analysis and design
section be the same

2- If some sections not pass the stress capacity check, this mean
you need to add larger section to the auto select list

e To check the sections passed in design process or not click
Design —» Composite Beam Design —®Verify All
Members Passed thin the next form will be displayed indicate
if the members pass or not

: ?\ Al composite beams passed the desion check.

L&

v
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

1. Select all the members thin click Design —» Composite
Beam Design —— Make Auto Select Selection Null ,thin
the next form will be displayed

1. Click OK button to remove the Auto Select Section List
~and Replace it with the Design sections which is mean
every element reassign again according to the design
Sections. |

7. Review the Result of Design
2. Right click on one of the composite beams the program will
display the Review form, you can click of any of the icon of

this form to make any change in design data or to check any
of the results data

121
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

P-A Analysis :

» This option is particularly useful for considering the
effect of gravity loads upon the lateral stiffness of
building structures, as required by certain design codes

e P-AForce:

¢ The resulting member forces and moments and the story
drifts introduced by PA effects shall be considered in the
evaluation of overall structural frame stability and shall
be evaluated using the forces producing the
displacement of As

Note:

e When you request initial P-Delta analysis, it is performed
before all linear-static, modal, response-spectrum, and time-
history analyses in the same analysis run.

® The initial P-Delta analysis essentially modifies the
characteristics of the structure, affecting the results of all |
subsequent analyses performed. As an important exception,

e Initial P-Delta analysis does NOT affect nonlinear-static
analysis. Nonlinear static analyses consider the P-Delta effect
separately, if requested

* ETABS PROGRAM has the ability to calculate the PA effects
by tow different methods

1. Non-Iterative -- Based on Mass
2. Iterative -- Based on Load Cases

e The next table show the difference between the tow methods

LLT
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Chapter 6

Non-Iterative

Iterative

iterative solution

iterative solution

automatically from a specified
The load .
computation from the mass at | combination of
P each level static load cases
Accuracy approximate accurate
not require an require an

iterative solution

Time taken in

Take more time

analvsis much faster than Non-
y Iterative
It does not
local buckling capture local It captures local
) buckling
' buckling
Gravity Load It is not needed Itis needed.to
.o to define any define gravity
Definition .
gravity loads loads
Not
Recommendation Recommended Recommended

e In the next steps we will explain how to use the Iterative

method in analysis to take the PA effect.
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

1. Click the Analyze menu —p Set Analysis Options
command to bring up the Analysis Options form.

Analysis'Options

1-to be
checked
2-click this
button
2. Check the Include P-Delta check box

3. click the Set P-Delta Parameters button

has

the P-Delta Parameters form will be displayed

* -~ Method

™ Morriterative - Bazed on Mass

erative - Bazed on Load Combinatior

~ Iteration Controls

b aximurn terations

~P-Dela Load Combiration

Load Case Scale Factor

IDEAD w1
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Chapter 6

e From previous form we will define the next Data:

e Method:

o Check Iterative-Based on Load Combination.

e Iteration control:

o Maximum Iteration : A reasonable number is usually 2

to 5 or any number according to your building (we will
make our maximum iteration 3)

Relative Tolerance — Displacement: The default value
is 0.001. If the relative change in displacement from one
iteration to the next is less than the tolerance, and we
will keep it as it is.

e P-Delta Load Combination:

128

o some of the engineers are confused of this item because

they suggest this item represent the all load of
combinations which the program will use in analysis and
this completely wrong the load of combination which
we will put it in this cell is the initial value which the
program begin its iteration, we already have in our
example according to ACI 318-02 code 22 case of
loading, the program will use it all in analysis but you
must Specify the single load combination to be used for
the initial P-Delta analysis of the structure .in our
example we will specify the P-Delta load combination to
be 1.2 times dead load plus 0.5 times live load, and this
value is conservative. Because we take the first part of
the load of combination of earthquake (1.2 D + 0.5 LL +
Ex) and we have another combinations less in value like
(0.9 D + EX)

o To Add the load of combination deﬁnition

TRUNG TAM PAO TAO XAY DUNG VIETCONS Vi ETCON S
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

1 Select the load case name from the Case Name drop-down
box. (Dead)

2. Type in an appropnate scale factor in the Scale Factor edit
box. (1.2) | ,

3. Click the Modify button.

4. Select a new load case from the drop down list (Live)
change the scale factor by typmg directly in the Scale
Factor edit box (0.5).

5. Click the Add button.

ita Parameters

N

click Okkagain in analysis option form
7. After the last step , run model and the program will take
automatically the P-Delta effect

=

129
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HOW TO MODEL AND DESIGN

HIGH RISE BUILDING USING
ETARBS program
- -
Dynamic Analysis
Chapter o

TRUNG TAM PAO TAO XAY DUNG VIETCONS Vi ETCON S
WWW.Vietcons_edu_vn ALWAYS BESIDE YOUR SUCCESS



1) Modal analysis

e Introduction :

» All Structure behave dynamically when subjected to
load or displacement

e Additional inertia force (from Dynamic behavior)=
Mass X acceleration

e If the load applied very slowly the acceleration value
will be small hence the additional inertia force will be
small and can be neglected, and static load analysis can
be justified.

e The acceleration of earthquakes can not be neglected
hence the additional inertia force can not be neglected
too (especially in irregular buildings)

e The conclusion is, it is better to make dynamic analysis
for all the buildings not only for the buildings which is
mentioned in the codes, because it is very easy to make
dynamic analysis as we will see in the next lines ,it is
not need more efforts to do it, and this is the actual
behavior of the building.

The first step in dynamic analysis is modal analysis

Modal analysis: are initially conducted to determine the elastic
periods and the modes of vibration. This simple analysis is also useful
as an initial validation tool of the analytical models. And modal
analysis is step one for response spectrum analysis and time history
analysis.

Type of analysis:
- 1-Eigenevectors 2-Ritz vectors
TRUNG TAM DAO TAO XAY DUNG VIETCONS VIETCONS
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Steps for dynamics analysis
1. Click the Analyze menu ——3»  Set Analysis Optlons
command to dlsplay the Analysm Optlons form.

‘A Elgenvector.» € RizVectos

‘ElgenValueF‘ararrmm SR e
: Frequency Sh;ft [Center} . ﬁl———* e

"lykL‘,utoff Flequency [Radnus] o ﬁ__._..__.__. '
~FlelatweTo!erance o i"mﬁé‘ﬁ?"" o

- inc!ude FﬁesxdualMass Modes

| Lstoflosds  RizloadVecus |
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3. Set the number of Eigen or Ritz modes to 20 in Number of

4. Check Ritz vector check box, thin the form will be as in the
next fig.

~ Mumber of Modes [0

~"Typé‘oféhdy s~ —
" Eigenvectors & Ritz Vectors

. EiQen“s}’aer P Eﬁamcicn; ’, -

Freouency Gt [Cente . ]

5. Click OK button in Dynamic Analysis Parameters form ,and
Analysis Option form

6. Run the modal
7. once the analysis is completed ,click Display menu —p.

Display Mode Shapes ,thin the Mode Shape form will be
displayed o

133
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8. click OK to
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9. To display another mode shapes click Display menu .
Display Mode Shapes ,thin the Mode Shape form will be
displayed ,click in the arrow beside the mode number box to
make the number 2 instead of 1, thin Click OK to display the
mode shape 2

10.In addition to graphical display tabular result are ready and
available to display ,to show the Modal analysis result click
Display —» Show Tables , The table generated shows the
buildings mode

‘Bm“lding Modes
L Edt wew

11. To display the another result for the modal analysis choose the
result you want to display from the down pull box which is
marked

Joirh
{ad
L
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odal Load Participation Ratios
Edit Wew oo :
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2) Response Spectrum Analysis

e Modal analysis : is the first step to begin Dynamic analysis
e Types of Dynamic Analysis:

1. Response Spectrum analysis
2. Time history analysis

Note: Response Spectrum analysis is more common analysis and time
history mainly used for research .

Response spectrum analysis Are calculated using the ordinates of the
appropriate response spectrum curve which correspond to the modal
periods. Maximum modal contributions are combined in a statistical
manner to obtain an approximate total structural response.

1. Click the Define menu . Response Spectrum
Functions command to access the Define Response Spectrum
Functions form.

Define Response Spectrum Functions

ig—Respbriée Spestra—— - Click fo: —

| ~ Add Spectt&z‘frufb‘File{.;,'3 ,
: 1

gﬁxdd User Specium

o Cénce! } :

Add User Spectrum e

Add Uzer Spectrum

Add BOCAIE Spectrum
&dd NBCC35 Spectum
&dd 1BC2003 Spectrum - —
Add HEHRPYT 5 pectium
Add EuraCode? Spectiurn
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Chapter 7

2. from the drop down box choose Add UBC97 Spectrum thin
the next for will be displayed :

Function Name:

iy Define Funiction

; Paramete[s'“ IR A
Period = Acceleration

. Seismic Cosfficient; Ca

" Seismic Eosfficent, e -

[ Convertio Uses Defined

Furction Graphy

[ . M N R DRRANANN EE R R

r Display Braph § 199266 . 0.0403)
o fﬁance( }

From the previous form adjust the parameters of seismic Coefficient
C, and Cy to be according to your area for zone 2A make C,=0.18 and

CV =0.25

138
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Response Spectrum UBC 97 Function Definition

1. Click OK the unction will be add automatically

Define Response Spectrum Functions

| Add UBCS7

Spectium

Mc:dﬁy.f’Show 'S'pécimrn.,‘ ]

Delete Spechum

2. click OK for the main form of Define Response Spectrum
Function

3. Click the Define menu 5 Response Spectrum Cases
command to access the Define Response Spectrum cases form.

139
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| Chapter 7

Carcel

4. Click Add New Spectrum button, to display the Response
spectrum Case Data

ectrum Lase

i Spectium Caseﬂé = !

. + Stuctural aridFuncﬁon&ampn i

Daripirig : 1 : X SpeCIfy

F‘MOdat Combination s : i the name
SRS L_1-aBS 2 SN
L O3y O O to b Spec
i g i X

. Dfrectional Combinatiank~ e
CEEISRES

T BES 35

i s Modified SRS S [Chines

Choose the / | o Scale factor =
foction we B S o . 9.81

was defined Excitation angle
bfore | Eccentricity ,
% Eccenticiy ERCE
“Overide Eccentricities -
[ ok { Cancel ]
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Thin the form will be as in the next figure

Response Spectrim Case Data

o Specttuih Case Nain

o Stuctiral and Function Dampin

Diamping

# - Modal Conbination : e
. @uoc. OsAss OB OGMC

Eaama) - f

. Directional Combinatian -+
GISRSS
rapS < SF
7 Modified SRS [Chinese}

: tr‘putﬁespohﬁ;é Spaihgoee oo
Dt unchion

Excitation arigle:

’Eocentrir::ity : :

% Eceenfricty’

Override Ecoentricities

: kipm; 1 :[ Cance|}’

~ Thin click OK for this form and OK for the main form
’5. Run the modell
6. After the analysis run is completed, click display menu

. ——— Show Tables to display the result of the run and |
make scaling for the dynamic force
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Chinose Tables for Display

SMPMODEL DEFINITION {0 of 71 tables selected)
[J Building Data
#-[7 Property Definitions
Load Definitions
[1 Point Assignments
#] Frame Assignments
-] Area Assignments
#-[] Input Design Data
&0 Design Overwrites
1 #[J Options/Preferences Data
e[ Miscellaneous Data
ANALYSIS BESULTS {4 of 22 tables selected)
e[ Displacements
[J Reactions

uilding Output

#7] wall Dutput

Check this bx [ Savediimedse ]

Click OK

Thin the next form will be displayed, from the pull down box of
displayed data choose Story shears

Thin check the first story result and divide the base shear of EQX/base
shear or SPECX to get the scale factor
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e You have 2 choice for the

scaling

1. Multiply the scale factor
x9.81 and put this value in
the Response spectrum case
Data. but this method need to

run the modal again

e Thin create the load of
combination and complete

your design steps

TRUNG TAM PAO TAO XAY DUNG VIETCONS
www.vietcons.edu.vn

Strvetural and Fupchion Damping

o dodal Combination

Input Fesponse Spechia

Spectrum Case Hame
Damping s

YOO CISEES (D ABS (D GMD

3 8BS
™ Modifed SR

Funchion

Direction

U1

Excitation angle L

Epoentnciy

% Ecoantricily 0

Dvemde Ecoenticiiss Overtide... |
[_or ] {Cancel |
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: Chapter 7

2.

144

for scaling with reference to
- EQY

create the load of combination and multiply the coefficient of
the spectrum by the scale factor .and this method not need from

you to run the model again

Load Combi natian Data

Load Combination Name

Load Corbination Type

- Define Combination ="

Care Name 7

Upconzs |

(™ add

after you change the scale in all
load of combination begin you
design steps

repeat the previous steps in Y
direction and the same method

we Spectrum Case Data

ol Combination -

iom T

Oy BBS GMC

@eac  O5Rss

o

i Diretional Combination——
RS

) ABS -

-y Medified SRSS [Chin

“Input Besponse Spectrg -

Direction. - Function

mo [

E gqcitation angle

. Evcentricily

#% Eccenticily

Overnide Ecoentricities

[ Cancel ]

[ or )
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There are some conservative opinion for the combination of the
spectrum cases and the most conservative one to take the response in
the both direction in the same case and scale the both. But till now this
opinion not used in the wide range :

'Rgspii:mse‘ Spectrum Case |

- Moidal Combination
@A Osks

Input Flesponse Spechias

Directia Fuirict

/U1 FUMECT

Excitation angle

Eccentricity
% Eccentrioty -

Overnide Ecoentiicities
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Why we need to use Sequential Construction:

1. In cast-in-place reinforced concrete structures, the amount of
support shortening before slab installation is of no importance,
since the forms are usually leveled at the time the concrete for
each floor slab is placed.

2. To analyze incremental construction, the structure is modeled
as a series of stages. In the most common case of construction
sequencing, each subsequent active group will include the
previous active group plus some additional objects.

3. the straining actions which is created in each structure elements
are effected directly by the sequence of construction ,and it is
varies from sequence of construction to another sequence
because the values of displacement for the points effected by
the method of construction where forms are usually leveled at
the time the concrete for each floor slab is placed.

4. The big difference in result for the members supporting planted
elements like columns and walls.

Assumption of the example:
1. the sequence for construction is floor by floor

2. we will use the full dead load during construction .(In reality
we can use OW only plus the construction loads)

Steps for Construction sequence:

1. Click the Define menu — Set Analysis Options command
to display the Analysis Options form.
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Chapfter 8

n Sequence Case .

5 robetive Stucture

(g Eté’ate;é.'ctive Structure

r ‘;sterSpeoiﬁedéntﬁve Stguctp(e L

Defau!t Desngn Combx:xs

~~Auto Dreafa Aclive Structure - -

: *Geometnc Ncnlmeauty Effem =

Create Ecrnstruchcn Sequence Bvery 1 Staries

Mone :_j
L oad Pattern- -
. Load Scale Factos
1DEAD ot 1B
i = CAdd |
Modlify %

|

i

i
i
i Delete §

k ‘Cancke!. 1

2. Select Construction Sequence Case option and keep the name
of the case as it is (DEAD-SQ), if you want to use the result of
CONSTRUCTION SEQUENCE in design instead the dead
load case check the box of replace Dead Type Cases with this
Case in All Default Design Combos.

3. From Geometric Nonlinearity Effects drop-ddwn list, choose
None (is recommended that the analysis be performed first
without P-delta)

g MNane

|P-Delta
1 P-Delts and Lkarae Displacements

4. In Load Pattern area. Use the edit boxes, buttons, and diSpiay
lists in this area to specify the Load Pattern we will use the
default of the program Dead load case with scale factor 1.

5. From Active Structures options. We w111 Choose how the
structure will be defined: |
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e Auto Create Active Structure option. Select this option to
have the program automatically create the active structure.

n Sequence

Acﬁve Shiich

£ Nore t : <\ & biso Treate Aotive Stuchie
& Construction Sequence Case %DET}"D'SQ . o £ User Specified Active Stiucture
~ Fieplace Dead Type Cases with this Case in all . T g
Drefault Design Combos Sl

Geometic Monlinearity Effects - '“Au'to C‘reateﬁmtive Stracture R
:  Creste Cbnsﬁructim Sequence every 1 Stories

- Load Patterr—-r—rr : i
Load Seale Factor :

s ot | sz Sgecifythe;tNo. of
- o | \ nce Story
tdodify - eq

. Delete i V4 i

Not active

x zwf L

Cancel j‘{ .

o User Specified Active Structure option. Select this option
to define the construction sequence manually.

: ~ Active Shucture

i~ MHone

& Corestuchon Sequence Case’ |DESD S0
- Feplace Dead Type Cages with this Case in all
Defaul Dasign Dombos

-+ Geometric: Honlinearity Effects ——

. Load Pattem - ‘ e o ser Specified Active Shructurg oo
Load Scale Factor : “dctive Groug

{DEAD Rl , o
DEAD Rl S _ Add i Add

i foidib, { o
% ; Modify ¢ b ooy
i Delete § et |

Create Atomatically e
. 77 Loads Apply to Added Elemerts Only
Ok % wffncei *
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Chapter 8 -

. User Specified Active Structure area. By default, the
program creates an initial sequence on the basis of Story
levels (e.g., Story1-SQ, Story2-SQ and so on). Use the
buttons, drop-down list and display area in this area to
add, modify, insert, and delete the groups and stories in
each construction sequence.

Corel fromlevel 1 tolevel 8
Core2 from level 9 to level 16
Core3 from level 17 to level 25
Core4 from level 26 to level 34
Core5 from level 35 to level 40

e Loads Apply to Add Elements only check box. When this
check box is checked the specified Load Pattern will be
applied to the added elements only. This box usually should
be checked if more than one stage exists. When the check
box is unchecked, the specified Load Pattern is applied to
the entire structure.

e fichive Structure

T None g - 7 futp Creats Aotive Stuchus

; s

# Constuction Sequence Case 1PESDS0 & fiser Spedied Active Stuctus?

= Feéplans Dead Typs Casesvith this Case inall
Default Dezigri Combos

= Geometic Honlinearity Effects

{None -]
rLoad Patterm s Hsei Specified Active Shucture
Load Soals Faotor . Sative Grouo
} - f .
IDEAD ~ii (o Stage . B15g 1 o
DEAD s Ao ; o Aod |
! | bodty | Mody |
i 1 —
% % Delete % Insert %
Drelate ’

L5 Loads Apply 1o Sdded Elements Only

N

-

[
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Keep the form as shown in the fig. thin click OK
Click Run Analysis Button

~ o

8. After the analysis completed Click
Analyze menu—— Run Construction Sequence Analysis
command to begin the construction sequence analysis.

e Example

o we ill see together in the next example the difference
between normal analysis and construction sequence
analysis

o The next form show the display of construction
sequence result. Click Display—» Show deformed
shape ,thin the next form will be displayed

Static Load =)
bz Loard

]

ie futo

{ Seale Factor

W Cubic Curve

]

Carcel |

o Choose the sequential load from Load drop-down list
thin the form will be as shown

i i
e
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| Chépter 8

Deformed Shape

Load'

Step I |

..

€BESD50 Static N

|~ Scaling

i Auto o
{7 ScaleFactor 4

i Cubic Curve

Cancel i

ok |

~ The step of
~ constration

o Click OK to see the first step thin click for the arrow in

the down of screen to see all the steps

o e

wnmm;wzmmww

TBG SRER DT W

B 7% vt Vi ) it Bt (FADSQ S 13

oy ¢ W K. D EM

W;giimﬁmyﬁémamt’n/

The deformed shape
of the first step of
constration segnce

The lding after
displaythe hole steps
of constration
segnce
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

o There are big difference in result between normal

analysis and construction sequence analysis as shown in
the next 2 figure.

PR ETAES Hindisiar w00 s K
T gn B el T i
Dok B ¥

_ o The vala for
J4 T o
| displacement is
7 _~ | notthesame

el imann mlons  w

The vala for
the Moments is

not the same,
% anditis
different for

each level

Jroecbe
L
Lad
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

“tabs Program has the ability to define unusual frame element
sections like (beams and columns) and unusual walls sections, and
also calculate the section properties for those sections.
1. Section Designer for Frame Elements: We will define two
different shapes to the program one for beam and another one
for column as an example to show to you how you can use
Section Designer.

@«j[] = 1 & FE[ 1] IEEE] [
]
. L i
AR 8 Tt
» ! =
‘ ‘ ] i
‘e '

J

|

v

.
Gnian

Sec (1) Sec (2)
All dimensions are in mm

Section (1)

1. Click the Define menu —® Frame Sections ....

P
I
N
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Chapter 9

- Or click Define Frame Sections button Ty

Display the define Frame Properties form

ﬂeﬁng Fram'e Properties -

~Pmperhco -
Typein prc:perty to fmd

~Click to:—

| JACompEm

1A GravBm
Aa-GravCol
Ha-LatBm
14:-LatCol
Ab-TrChdw10
H:-TrChdw/12
B-TrChedwi14
A-Trw'eb8
A:-Treiebl0
1a-Trwebl2

; §Add Awide Flange

Modifp/s how F‘top ertu

which will

Delate Property

 Add | /wide Flange

Cancel i

&dd Fipe

Add Rectangular
&dd Circle

Ldd hensral
“dd l‘v?t‘el Joigt

Add Nonprzmatic

e

2. Click the Second drop-down box that reads “Add I/'Wide
Flange” and Choose Add SD Section from the list, thin the
form of SD Section Data will be Dlsplayed

!.E-«A)
1
o

‘SE} Sec,tmn E)ata

_ SectionName

8 asi:-, M atenal

;éDTHEH ‘vg

"V*DesxgnTypc‘ —
& No Checka’Desrgn

,8&cmn'Besxgneu.~ o

Dlsplay Colﬂ: ‘
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HOW TO MODEL AND DESIGN HIGH RISE»BUILDING USING ETABS PROGRAM

e In thlS form change the section name to SD BEAM
or specify any another name

e Click the drop-down box of Base- matemal and
choose conc. or any material you was defined before

§1:JTHEP ~]

e After you choose any concrete material the No
Design/Check option and the Concrete Column
option will be available, highlight the Concrete
Column option to allow the program to make design
or check for the section after analysis

e For section (1) we will inake the prografn check it ,so
hlghhght the Remforcement to be checked

Jomct
51
|
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Chapter 9

3. Click the Section Designer button to go to the section
designer utility and draw the section on the next screen

AN

The nits

will b the
same as the
model nits

e Click Draw menu —— Draw Solid Shape ———»
Rectangle  ora |

_ Reshape Mode
. Draw Structural Shepe ¥
i PR cirde
Draw Reinforcing Shape Segment
Draw Reference Lines " Sechor

Constrain Drawn Line to

e Or Click Draw Solid Shape button thin Rectangular
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Rectangular Shape will be displayed, click on the Guide
intersection

\ =

Click here

e Thin the Rectangular shape will appear ,click escape and left
click on the shape by mouse thin right click to display the
Shape Properties -Solid

Shap‘é i;rﬁ ; rtnas —smm

Y
LI
O
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_chaptero_|
Chang the size of the section to be 30x70 and from

~* Reinforcement drop-down box highlight Yes to add
- Reinforcement to the section ‘

Shape Properties - Solid

Fenforcing

Carcel |

¢ Thin the section will be as in the next Figure

e To adjﬁst the reinforcement click on the left edge by the mouse
thin click the right button of the mouse to dlsplay the Edge ’
emforcement Form

fommr
ch
L
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

dge gewiniciig

e From the Edge Reinforcement form adjust the side Bar size to
be d12 and The Bar Spacing to be .35 and The Bar Cover to
be .03

1-Adst the
Data

Bar spacing
egl to the
half edge
distance to get
one br

2-Click OK
Btton

\ 3-the side will b

changed as in the
figee

e Repeat the previous step for the left side ,thin the shape will be
as in the figure

161
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“Chapter9

e For the top reinforcement repeat the same steps and enter the
following data

e For the corner bars click on’ the Bar by the mouse thin click the
right button of the mouse to display the corner Point
Reinforcement Form modify bar size to be 16d

s

162
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e For the bottom reinforcement repeat the same steps for the top
reinforcement and enter the data as in the figure

Edae Remforany

e To display the properties of the section click Display menu
. —» Show Section Properties, thin the next form of the
section properties will be displayed

Praperties

 4B46E03
8.575E-03
1575€-03
0.

0175
0175
0.0245
0.0245
0.0108
0.0105
0.0368
0.0158 -
0.2021

e To display the interaction diagram for the section click Display
menu ——p Show Interaction Surface, thin the next form of

163
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the Interaction diagram for the section according to your design
code will be displayed

~ Optiors i e

Pany e
- phi e ; s é Flan
i : R ) 2 i

oo phi o 335 j Elevation

iwhfyrciease || g | m | pua] Pz

e In the end the beam section will be as in the next figure and
ready to be checked , click Done from the form and thin Ok
from the main form

siamempmme

Click Done from here
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

L  Section Name

 BaseMateid  JCONC <]
Desin Type——— .
7 MoCheck/Desion

i Concrete Colurmn

Click Ck to ~ Caricrete Column Check /D esign
add the ¥ Reinforcement to be Checked -

£ R einforcement to be Designed

section to
the define Define/E dit/Show Sectinn—
jist ‘ b

Section (2)

1. Click the Define menu ——p Frame Sections ....

165
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Chapter 9

Or click Define Frame Sections button 1 which will Display

the define Frame Properties form

Define Frame Properties

[irpart 1wide Flange

.f-‘k.dd lMd kf-k'lan' e

A-Tiweb10
1 ga-Tiwebl2

Add Pipe
" | Add Rectangular
1Add Curcle

Add Auto Select List
’Add Nonprismatic

2. Click the Second drop-down box that reads “Add I/Wide
Flange” and Choose Add SD Section from the list, thin the
form of SD Section Data will be Displayed

166
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' HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

fDesignTyl':x’é‘ :
| MoCheck/Desi

In this form change the section name to SD Column
or specify any another name

Click the drop-down box of Base material and
choose conc. or any material you was defined before

OTHER  +|

Witeio radsem i Sesp vy e an s e et ]

[OTHER
STEEL

After you choose any concrete material the No
Design/Check option and the Concrete Column
option will be available, highlight the Concrete
Column option to allow the program to make design -
or check for the section after analysis

167
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Chapter 9 -

e For section (1) we will make the program check it so
highlight the Reinforcement to be designed.

50 Section Data

SBCOLUMN

3. Click the Section Designer button to go to the section
designer utility and draw the section on the next screen

o

168
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

s Click Options menu —»Preferences to adjust the
spacing between the grid lines, adjust the values to be as in the

. next form, thin click OK

oferarces

Spacing

Additional
grids

btween the
main

gridlines

btween the
Gridlines

meters

pisels
pixelz
pinels
pixels
- percent

. percént ;

The distance btween
the main Grids €m

Distance Btween anytow
secondarygrids &1 m
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Chap‘tér 9

e Click Draw menu—— Draw Poly Shape Or Click Draw

Poly Shape button < thin the crasser for drawing Poly
Shape will be displayed, click on the Guide intersection

....... i

g

e Click Snap to Fine Grid button #4  to allow you to snap to
the intersection of the secondary (fine) Grids in the drawing

Snap to the
intersection of
fine grids

‘J

e Click at any intersection of the grids to get the first point of the
shape ,thin click at a distance of 10 grids to draw the second
point

First point

Second point /

Distance &n
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Mh the help of the grid line  complete the drawing of the shape by
click of the point of intersection, after you finish the shape drawing
chck ESC button, and the shape will be as in next ﬁgure

Insertion
point
Centre
of the
shape

The centre of the shape not match with the insertion point
a. Tyou have eccentricity of the colum n you can move
the centre of the shape with the same value of
eccentricity from the insertion point
b. fyou don’t have eccentricity m ake the centre of the
shape at the intersection point

¢ To move the centre of the shape to the insertion point chick
Reshape button T choose the shape and click on the
point of the centre ¢ of the shape and drag it to the insertion
point ~
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Chapter 9 -

s Right click on the shape by mouse thin left click to display the
Shape Properties —Polygon, end from the drop down box of
reinforcement choose yes, this to make the program know the
shape of reinforcement

Tvpe T Pelygont
i Material COoMC
§Color

{Reiniopf |

o

=

)

g: 8
=

O

e Thin the section will be as in the next Figure
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

S St Dsphey  Dmers e
51 o} P w st

, &
g : /A:,
it
et y
e i
f
B i
i
B '
= ;
i »
E — E .
B : :
N roey ‘?;
" Eea it o
i W A
N : 4
s A
B !
-
&
- L
w 4
i * - e BTN, W s

Bawmes:

e In the end the column section will be as in the previous figure
and ready to be designed, click Done from the form and thin
OKk from the main form
You can also draw composite section with the same steps, the only
new step in draw this section is how to draw steel section

e To draw any steel section click Draw menu — Draw
Structural Shape——® [/Wide Flange, thin click on the
center of the shape

Select Mode
Reshape Mode

 Draw Strichutal Shape icke Henge
Drawy Solid Shape ¥ Charmnel
Drayy Poly Shape Tes

Drave Reinfordng Shape b Angle
Draw: Reference Lineg  # Diouble Angle

B/ Tube
Snap to L4 .
Hipe
Constrain Drawn Line © ¢ -
i
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Chapter 9 |

= ‘Canceii

Right click on the shape by mouse thin left click to display the Shape
Properties I/Wide Flange to adjust the dimensions of the shape

2. Section Designer for Pier Walls:

The main difference between the section designer of the frame
element and the section designer for the walls is the section
designer for the walls must be done after the analysis run.

174
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e Steps for Section Designer for the Walls.
1. Built the structure model
2. Run the analysis

3. Begin the design steps as we explained before in shear wall
design.

Important note: you can not use the section designer for the walls
unless you named the walls as a Pier before analysis run

4. Click Design menu— Shear wall design —® Define Pier
Sections for Checking, thin the next form will be displayed.

1~ Sections

 AddPierSection. |

. " Add Cn::py of Pier Section... j

l 0k 3 ‘Cam:el g

5. Click Add Pier Section to display the Pier Section Data form
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Chapter 9

Pier Section

_ SectionName [

sMaeral  [CONC ¥]

. 4' AddNewP Sﬂchon

: ';: atart frum Exwtmg Waﬂ F'&er '
e e

iz Deftne!’Edtb"C how SECMUI e
o r ‘ SectmnDeﬂgner ‘ 3

i Cancel 3

6. you have tow choice to begin the creation of the wall shape
e To Add anew Shape (the same steps as the frame
element creation)
e To begin with any existing wall and make
modification for this wall (Dimension or
Reinforcement)
7. choose the wall you want to change its size or reinforcement

The name of
the wall
The story Y Define/Edi/Show Section Wy _| The pier
where the / o [ SectionDesgrer. | || labl of the
wall fayin it o """ 1| wall which
it | Cancel WJN!H .
‘ modifvit
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

8 Click the Section Designer button to go to the section designer
utility and draw or modify the section on the next screen

e b e T b B

Sl S e el B )

9. To change the dimension of the wall click Draw menu —p-
reshape Mode ,thin the shape of the crasser will changed click
on the edge point by left button of the mouse thin right click
,the change coordinates form will be displayed, change the
coordinates according to the new size thin click OK

Lo
S »15
)
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Chapter‘Q f

mmmmmmwww

MM’% .

=l
le

The edge which has ben
changed

ileltlsl= Tl ol 4

Do |

e And for change the reinforcement follow the same steps as in
section (1)
e After you change the dimension or reinforcements click OK,
thin you will find the new section will be added

: Cickter -
(

[ &ed Copy of Pier Sechior,. ]

4dd Pier Sectior.. |

[ Modify/Show Pler Sechion. . ]

[ Delete Pier Section |

’ (oK ] [ Cancel |

10. To assign the new section for the wall.
e choose the wall

178
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HOW TO MODEL AND-DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

¢ Click Design menu—— Shear wall design —».
Assign pier sections for checking —— . General
Reinforcing Pier Section.

WlaLLT:

Choose the
section

® From this form choose the wall section in the top and bottom
of the wall thin click OK

e Follow the same steps of design as it was explained before in
shear wall design

179
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

ETABS is finite-element program based in the meshing and divide of
the structure elements. Also the Meshing helps distribute loads
realistically

e There are 3 method of meshing
1. Manual meshing

2. Automatic meshing
3. Meshing done by special program for meshing

1. Manual meshing: we use Manual meshing for the next cases

1. for the complicated structure shapes
2. for the structure have curved edges or combination
between rectangular and circular shapes

e The most common use for manual meshing is done using DXF
files thin exported to Etabs program. the manual meshing is the
most famous method done by the most of Engineers

2. Automatic meshing: we use Automatic meshing for the next cases

1. rectangular and circular structure
2. Deck slabs
3. Slab properties with membrane behavior only

¢ The Automatic meshing is powerful tools from the program
save your time and give you the ability to change the size of
meshing at different runs according to the accuracy you wanted
from this run

e To use the Area Object Auto Mesh Options form to control
meshing of area objects

1. Select the area object to be meshed

gL
£ s

TRUNG TAM PAO TAO XAY DUNG VIETCONS Vi ETCON S
WWW.Vietcons_edu_vn ALWAYS BESIDE YOUR SUCCESS



Chapter 10

- 2. Click the Assign menu—3 Shell/Area——» Area Object
Mesh Options command to display the Area Object Auto
Mesh Options form.

3. On the Area Object Auto Mesh Options form, select the desired
options from the following choices:

<+ Floor Meshing Options

> Default (Auto Mesh at Beams and Walls if Membrane - No
Auto Mesh if Shell or Plate) option. This option meshes the
objects at beams and walls, no meshing for the object which is
defined as a shell or plate,

> For Defining Rigid Diaphragm and Mass Only (No Stiffness
- No Vertical Load Transfer) option.

» No Auto Meshing (Use Objects as Structural Elements)
option. No méshing for the elements

> Auto Mesh Object into Structural Elements option.

= Mesh at Beams and Other Meshing Lines option. Similar
to the default option.

= Mesh at Wall and Ramp Edges option. Meshes the
selected object at wall and ramp edges

= Mesh at Visible Grids option. Meshes the selected objects
at grid lines in the floors level.

The 1mportance of the visible grid:
1. guide for the meshing

2. take the effect for the columns and another points which the
program don’t taken in consideration in meshing

3. to make the secondary grids for the méshing

182
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

a. select the points of the columns, end of the walls, and
point load

b. click Edit menu—-Edit Grid Data—» Add Grid
at Selected Points, thin the next form will be displayed

-~ Orientation -
- BPaslelto X
O Paalelto Y

k : § 0K fj l Cancél [ ‘

¢. Click Ok for the Orientation Parallel to X ,thin repeat it
for the Orientation parallel to Y

e Also You can make meshing for one floor different than other
floors to reduce the effect of the meshing of this floor to other
floors ,

a. click Edit menu———- Edit Grid Data— Edit Grid,
thin the next form will be displayed

1! Click here to add
‘ . new sgtem
Add Copy of Systern... A
Modify/Show Gystem. |
Check
onvert to General System thl S bX
B — {_ ok 1 [ Cancel |
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'Chapter 10

b. Click Add New System button to add new coordinate

system

c. check the box reads Convert to General System

d. Click modify /Show System Button to display the Grid

System Data Form

- Garid Spstem

‘ “G;;dﬁneg' A

; BT e

Systetn Ciagin:

Global ¥

‘( 4ddMew Grid Lire... |

Global ¥

Rutation_ (degl

| [ Modiy/Show Gind Lire. ]

S Delete Gridbin

e. Click Modify /Show Grid Line button to display the Grid
Line form , from this form choose the floors you want your
system of Grid to be applied from From Top & Bottom
Story drop dpwn box and check the box of applay to All

thin click OK

Grid Line 10

V”Typ& of Gridlire .
=3 Straight Line
de

Flar Coordinates :
oo
Y1
w2

¥z

e Options

Top Ston

Battom Story

(=) Primary Lite

" Secandary Line

"] Hide Grid Line
[} Switch Bubble Location

Bubble Size 125

Crodor

i | Cancsl |

~. Zoply to Al ?/ C?hed(
) is
e bx

U STORY4D v
STORV &~
STORYA

STORYZ
STORYZE
STORYIE %)

O
g
O
0
O
O
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

=  Further Subdivide Auto Mesh with Maximum Element
Size of {specify value} option. Meshes the selected
object(s) using the specified maximum element size.

B,
(2

» Ramp and Wall Meshing Options
> No Subdivision of Object option.

» Subdivide at Wall Openings option. Meshes the selected
objects at wall openings.

» Subdivide Object into {Specify Number} vertical and
{Specify Number} horizontal option. :

- » Subdivide Object into Elements with Maximum Size of
{Specify Number} option.

3. Meshing done by special program: now there are many program

are specialized in meshing of the floors .you can use any one of
this program to get DXF for the floor ,thin Export the DXF to
Etabs Program

185
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e In this chapter we will talk about the relation between Etabs
Program and 5 of the most important program

e ETABS program allow you from importing and exporting to
share the data between the program and other programs

Etabs & AutoCAD Program

. ETABS .e2 TextFie...
\ . ETABSG TextFile...

- ETABS .edbFile... .
 oxrFie of Architectural Grid...

2-to import the floor plan (beams, P> DXF Foor Plan...
columns, and slabs) " DYF File of 30 Model...

1- To import the grid lines

/TFC ifcFile...
IGES .igs File. ..
CIS/2 .stp File. ..

Revit .exr File...

3-to import the full structure ProSteel .mdb Fiie. .
Frameworks Plus .sfcFile, ..
STRUDL/STAAD .gt/.std File. ..

TRUNG TAM BAO TAO XAY DUNG VIETCONS M Vi TCON S
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" Chapter 11 -

1. Import the grid lines

Save the AutoCAD which contain the Grid lines as DXF file
2. Click File menu ———» Import ——» DXF File of

Architectural Grid...
3 if this file is anew file the form of New Model Initialization

will be displayed, from this form choose Default.edb

[UNY

Dievypou want to initiaﬁze your new model with definitions and
. preferences from an existing _edb file? [Press F1 Keytor help

g Choose edb 1 [ Defauteds | | Mo ]

4. thin the Import DXF File form will be displayed

Etabs Beok

e ie)@mp!e1

 |DXF Fies [.DXP)
- .
5 Choose the file of DXF and Click Open; thin DXF Import
Form will be displayed
188
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

 Coord System  [GLOBAL sl @
‘SelectLayéiéfreriidg i =

0

EESMS

BRACES

CENTLIMES

COLUMNS

: D LG
~TFLODRS

TEXT T
[walls A ~

Global Up Direction {2 !

Ignc}ryéktinéa'5h0yr‘ter‘Thah‘ 30‘ ’ L ' 0K 3 Caﬁéé', i ’ Gz

Choose the layer contain the Grids thin click OK

2. Import the Floor Plan
1. Open AutoCAD Program
2. Open the File of the plane for the first floor or open new file in
AutoCAD Program and make 4 deferent layers
1. Beams : for beams and walls
ii. Floor  :for slabs
iii. Opening :for the openings
1v. Columns: for the columns
3. Draw the PLINE on the edge of the slab in the layer Floor, you
don’t need to draw 3D Face and mesh it yourself ,we will make
the program make automatic mesh for the elements

Direction of Drawing
The PLINE of the slab

Draw the beams and walls as lines in the layer called beams

VIETCONS
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Direction of Drawing A \
The beams and the
Walls lines

4. Draw the openings in the layer called opening as PLINE on the
edges of the openings

PLINE
for the

edge of ' | Lines for
the slab

bams
and
walls

5. save the file as DXF file named Examplel

6. Click File menu —p Import—p DXF floor plan,
which will Display the Import DXF File form
e T | L N
i |
4 File pame: %examuéei _'__i Open !
Mxpg%éﬁm Hesoftype:  [DXF Files " DXF ¥ Canedl }
aces I Open as read-only
‘N
1V
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Choose the file of DK and Click Open; thin DXF Import Form will
be displayed

DXF mport ¢ °

Beams.

C‘d!ukmnsk

Floors

Openings

*Plan Locatiormr"

iz Story Level

Pl

| Ignore Lines Shatter Thar, 0 ookl caneet |

| Global Up Direction

7. Make sure that the plan view is the view of story 1,if not Click
set plan view button rlg thin the next form will be displayed,
from this form choose story 1,thin click OK

}MRL
Lo
frh,
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Thin the floor will be displayed in the plan as foll

R W YEDIRT LlviaR g

owW

o e

7 The slab
f limits

!

1 r"“”
The |
centre L N
line of 3
the wall | L

8. Choose the wall centre line thin click Edit menu .
Extrude Lines to Areas ,and follow the same steps of chapter

(D

3. Import 3D Model
1. Open AutoCAD Program
2. Open the File of 3D or open new file in AutoCAD Program and
make 7 deferent layers
192
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

1.
il.
111.
1v.
V.
V1.
Vil.

Beams : for beams and walls
Floor :for slabs

Opening :for the openings
Columns: for the columns

Braces :for the bracing
Ramps :for the ramps
Grids :for the grid lines

3. Draw the PLINE on the edge of the slab and ramps and walls in
the corresponding layers,

| " Direction of Drawing
The PLINE of the slab

Draw the beams and columns as lines in the corresponding layer

Walls lines

TRUNG TAM PAO TAO XAY DUNG VIETCONS

www.vietcons.edu.vn

Direction of Drawing >
The beams and the

4. Draw the openings in the layer called opening as PLINE on the
edges of the openings
5. save the file as DXF file named Examplelor any another name

6. Click File menu —» Import——» DXF File for 3D
Model , which will Display the Import DXF File form

193
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Import BXF File

Choose the file of DXF and Click Open; thin DXF Import Form will
be displayed

L __ L 1-Adjust
DACF tmport ' the units

2-Select
the Layers

\ 3-Adjus
the

section:

Adjust the DXF File Units, thin choose the layers to import and adjust
the default Properties sections for the elements thin click OK

4. Export of DXF File from Etabs
1. Cligk Fil.e menu y. Export .y Save as DXF File,
which will Display the Export DXF File form

94
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

ETABS Braving Gensrat

2. choose the type of DXF File which you want to export
i. Full 3D Model View
ii. Column Layout Plan4Flor Layout Plan
iii. Beam Elevation
iv. Columns Elevation
v. Wall Elevation
vi. Full Frame Elevation
vii. Typical Frame Member Sections
3. Select the file name and the path of the file

195
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Select the file name
and the path of the
file

g Genra

4. adjust the Layers Name

5. Select Floors and Objects you want to exports

6. Adjust the Drawing Options

7. Click Generate DXF/DWG thin the generation process will
be displayed

196
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

~Drawmg?yps
7 Ful 30 Mudemew
,f“ Ccaiumn LayoutF Plan

(“ Floor Layou! Plan

Generating Full 3D Yiew
....Creating Line Objects

Colurans [12}

....Creating Area Objects

Walls [2193)
Cipenings (80)

1. Initializing DIF File

.. Mriting Entities to D¥GF File

1. Finalizing and Closing DXF

Select Floors and Ubjscts

i" Co!umn Eteﬂfak‘ Y
o Sl Elevation
" Ful Frame Elevalion

D¥F File Creation Complated
: d'S

Select Elevations ..

Draving Options
Typica anme Mertber Sacnons | ;

: Gengrake DXF/DWEG ;

8. after the program finish the generation Click Close
9. open the DXF file by AutoCAD program

nuee Ffzﬁﬁn

Zpda

s
s
o
o1 a
o )
g
ol -
At -
B 1
o P
H i
B 7
- I
i
B
B
T

i’“” o
o
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e Etabs & Safe Program

* The program give to you the ability to export the floor plans
to the safe program

* You don’t need to remodel the slabs again in the safe
program, you can use the same floor plan of Etabs program
with the effect of all static case of loading (Dead, Live,
Earthquake X, Earthquake Y, Wind X, Wind Y)

* Also the program give to you the ability to export the
reactions of the walls and the columns to Safe Program to
Solve the raft Foundation

Note: to take the effect of the earthquake and wind load, you must run
you model before exporting the reaction of the columns and walls or
the floor plan

1. Export of Reactions of the columns and Walls to Safe Program

* Click File menu——— Export— Safe Story as SAFE
f2k Text file , which will Display the SAFE Export Options
form

STORY4N e
STORYT A
STORYE -
STORYS
STORYY
STORYS
STORY?

&

U Espont Floor Loads plu;[lolumn and Wall Distortions |\ ; :

| LosdCasestoExport

@

Check this
check box
TRUNG TAM BAO TAO XAY DUNG VIETCONS VIETCONS
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e Select the story level to export from the drop-down list of
Story to Export to be Base.

e Check the box of Export Floor Loads and Loads from
Above to take the effect of the loads of all floors

e Click Select Cases... button to display Select Load
Conditions Form ,thin highlight all case of loading thin
click OK ,thin click OK for the main form to display the
Save of the file form, Name the file thin click Save

xi

Saveastpe:  |SAFE Tex Fles [ F2K) e

4

e Open safe program and click File menu——* Import—® .
Safe v6/V7 F2K File ,thin the next form will be displayed
.choose the file thin click Open

199
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=
| SAFE Flles "F2K0
I Operias read-only

. b i
% - 2 *ji“ ; % i ﬁ \
T R AT
| gt o< 1| The columns
5 35 SN e PO S T 13 and walls
i e o e di
: : = . “ '
T TEIR R and its
g i i e e reactions
}_,,&.”m e 1 i i Puua:ii:&
{4 B 3 2
ok o SO +
o0 E

2. Export of the floor plan to Safe Program
e Click File menu —» Export——»Safe Story as SAFE

f2k Text file , which will Display the SAFE Export Options
form

200
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

SAFE Export Options

Story to Expor STORY 40 : v

spart Floor Loads Tnlp

Tortxport Floor Loads and Loads from Sbove

{7 Export Floor Loads plus Column and Wall Distotions

Load Cases to Export [ Select Cazes. . 4/

Chm ok ] [ Concl | |
check box

e Select the story level to export from the drop-down list of
Story to Export to be Story 10 (as an example).

e Check the box of Export Floor Loads Only to take the
effect of the loads of the floor and it is not recommended to
check Export  Floor Loads plus Column and Wall
Distortions because as we explained in the chapter of
construction sequence this deformation not have true value

e C(Click Select Cases... button to display Select Load
Conditions Form ,thin highlight all case of loading thin
click OK ,thin click OK for the main form to display the
Save of the file form, name the file thin click Save

Save SAFE F 26 Toxt File As

STORY1D

SAFE Text Files [ F2K) )

)
-
Lok

ONS
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* Open safe program and click File menu—» Import — .
Safe v6/V7 F2K File ,thin the next form will be displayed
,choose the file thin click Open

> =B

Fle name: [sTorv10 = [ |
Flesoftype:  [SAFE Fios (1260 X Ceed |
™ Open asread-only :

¢ Etabs & SAP Program
e if you want to add certain other special purpose elements to

your model which are not available in ETABS, such as Solid
elements ,you can export your model to SAP program

P
.
P

O VIETCONS
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e after you export your ETABS model to SAP2000, you can not
import that SAP2000 model back into ETABS

e Click File menu—® Export— Safe Story as SAP2000
s2k Text file , which will Display the Save Export File As
form ,write the name of the model thin click Save

e {@ Wodel

Myﬂammerts

(] e = [ ]
=~

Mywamﬁ; Savesstipe. ~§sapzmjem Fi 32 Cancel |

: P!anes

e Open SAP program and click File menu—> Import —#.
SAP V8/V9/V10 S2K Text File ,thin the next form will be
displayed ,choose the file thin click Open

Ty Doscuments

. H ¢ 7
File name: jexample 1 __*:j i Open %

My Networe  Files of iype: SAP2OD files T s2K: *.52k) ~ Cancel |
Places o o — -
¢ Qpen as eadony
VR
203
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o Etabs & Word Program
_® You can display any input or output result in tabular form which
we can open it by word program ,thin you can adjust this result
format according to your company format and use it in the
calculation sheet of the building

e As we explained before in the chapter of Display result The most
important tabular review for the result is the summery report which
gives to you the most important data for the model and the
calculation details for wind, and earthquake loads, and the
summary for the result
1. Summary Report

o Click the File —»Print Table ——» Summary
Report, thin the form as shown in fig will Display.

fw Print to File I~ Append

File Name. . i

gC:’xMakax’xdata\Nev-;foider 2hdubal courzehexample

aK Cancel g

e Click FieName.. to choose the location where the file will
be saved using the next form

204
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Open File for Printing Tables

Savein ; i final notes v 4= e Ed-

. H H 3
File name jexample 1 > Save i

My Metwork ~ Savesstype:  |Tex Filss (i) he Cancel
Places

e The next form will show to you extract of some
information in summary report (Earthquake calculation)
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AUTO SEISMIC INPUT DATA

sample 1+ Hotepad

Direction: X + ECCY
Typical Eccentricity = 5%
Eccentricity Overrides: No

period Calculation: Program Calculated
Ct = 0.02 (in feet units)

Top story: STORY4Q
Bottom Story: BASE

R
I

[

5.5

1

hn = 137.400 (Building Height)
s0il profile Type = sC

Z=10.15
Ca = 0.1800
v = 0.2500

AUTO SEISMIC CALCULATION FORMULAS

Ta = ¢t (hna(3/4))
If Z >= 0.35 (Zone 4) then:

If Tetabs <= 1.30 Ta then T = Tetabs, else T = Ta
= Ta

1f 2 < 0.35 (Zone 1, 2 or 3) then: If Tetabs <= 1.40 Ta then T = Tetabs, else T

o
If T <= 0.7 sec, then Ft = 0
if 7

> 0.7 sec, then Ft = 0.07 TV <= 0.25 v

AUTO SEISMIC CALCULATION RESULTS

Ta = 1.9566 sec
T Used = 2,7393 sec
W Used = 499320.21

v (Egn 1) = 0. 0166w
v {(Egn 2) = 0. 08184
v (Egn 3) = 0.0198w
v (Egn 4) = 0.0349

vV Used = 0.0198w = 9886, 54
Ft used = 1895.74

AUTO SEISMIC STORY FORCES

STORY FX FY
5TORY40 1966.33 0.00
STORY39 306.18 0.00

MX

0. 000
0.000

By Mz

0.000 -1376.430
0.000 -489.882

You can see from previous form the whole steps the program do to
calculate the seismic force and the values of the force acting in each
floor in details ,also the program give to you the details for the wind

calculation , summary of the input data .and the results

=y,

£

06
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. HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e Also you can display the result mentioned in the next form and as
example of this result we will display the concrete frame design
for one of the beams of the tower

Analysis futput. e

Surnmary Report...

el Frame Desigr...
Lonaete Frame Design...
Cornposite Beam Diesign, 0
£

FYR I R P J—
Sies Jost Design., |,

Shear Wall Design...

» Select the element you want to display the result for it

e Click the File ——p Print Table —p Concrete
Frame Design; thin the form as shown in fig will be
Displayed.

Print Desion Tables

e Highlight output Summary and print to File thin OK ,thin
open the result file in word

207
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Loy BE  Sb4CKED £.500 L263R.04 GOCOND 4 539E04 2,000 UOCONES
SYeew) B8 e 0 <2600 WRUNL  3.2326-04  LOCOND 000 GICONBEL
ST Bl i d 500 Bl S . 500
¢ Tk B8 Sbégmun 10, G0 SEERE-E GOCOML 228304 ANCTME - 00 - GOCONSE
: S30mw] BB SB4GXB0 12000 SZEECOL KKXONL 23634 DO 7 .
SToRN] B3 SMnERD 3,500 SIRFEARE OEE 263604 wewG L D02 ADEORET
SToRw] BE Bl 11006 PB4 2263004 1 R
] o5 7 31830 BG4 LOCOML  T.2B3E-08  upooad K2 UDCENST
Sl CLIE 12,000 LS8R0 vexOwE 4. 278 amconet B
[ ETMES v5,0.3  FORIRXAMPLE ) Dntisaeen Drtasber PO, 0D YT PaEE 2
EOMERETE BEAM LESIGM GETEYT R IR
[ TOREION MM SMLAR GELIGH OF TONK-TYPT K1 EMENTS
e BB STRTION sravion e e WERKITREID SN IMG o v
T By £ W Rk G T ot SHERR g
FroRW] i) £.800 I09RE-G4  UDCONE S LBE-DN AXCONST
¢ Sroewi 84 SBAORRG 5,300 2.DURL-00 TOCOMS 5D S00U.04 UXoaEs
FroRN B SpiRs 1000 TURRE-00 CTCOMS % J13E -0 GDCONSR
] B8 Lstui0 1300 £.098-08 AOCOWT 5 IILEADE UOTOMEL
STCRWE, B2 SBUONGD 2.000 2058004 CDCONT X BETE-06 KOS
Srowwl &5 SBaORe) 2,000 GO0 SRXONRE :
TroRwL L 2,500
Sromyy BS  SEaEGy 3.00¢
STTENy B8 ZE4ORR 3500
ETOEWL B SeAlNG 4.0006
SFORWE BY Smadngn 4. 500
STERNE LU 2,300

Also you can Export the Etabs file to text file (E2K) which is less in
size and you can imported again to the program without any effect to
the model

e Etabs & Excel program
* After you display the result in tabular for click Edit — .
Copy Entire Table Ctrl+C

Pigr Forves
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~ HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

> Thin open Excel program and Paste the data and you can work
with file with all the utility of Excel program

IRITIIIIIBIRAR

: :@S SELS B3R
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HOW‘TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

New Model Initialization

¢ When You Begin the model you can safe more than 40 % of
the modeling time this by using the Definitions from existing

model |
e The program will import all the data from the existing file
except
= Grid Lines
= Story Data
=  Objects
= Assignments to objects
* [nformation on the number of
windows
e (Click the File menu ——» New Model the next form will
display

New Model Initialization

e From the previous form choose Choose.edb the program will
open menu of Open Model File

TRUNG TAM PAO TAO XAY DUNG VIETCONS
www.vietcons.edu.vn
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* From this menu choose the model which we created together
thin click OK '

e The first thing you will notice the units of the model changed to
be KN.m

e All material definition will be directly imported to the new
model

\ [ Addtewtomial ]

[ EONCeD .
CONCED i [ Modify/Show Material.. |
OTHER L ; :
STEEL ‘ :

i ”:!
}oCancel

model

e All the definition of the walls and slabs sections will be
imported to new model
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

PLANK
| SLABT
SLABZS
SLAE30
WAl L1
Wwall40
WaLLSD

| Add New Deck

o L ‘kModify!Shcheghon-,.,

: [ Dielete Section.

e All the definition of static and dynamic case of loading will be

imported to new model

 Lateral Load

Blodin

[ elete Load

Divection and Eccerdricty
O D
. % Dir+ EccenY
| (DX Dir-Ecoen

Y D
Y Dir+ Eccen’X

{3Y Dit-Eccen X

Ll s Seismic Zone Factol
% Eccentriciy oS »
Gverride € coentiicities : i
7 Timne Period i wior .

Sedmic Coefficients

b SAPet Code OUsevbeéirxed

[ SoifProfile Type

ErOrMethod 4k

: + i Neat Sowes Factor

: G)‘Pxog«am(:alc' CEify=-10.
- e Defined Ve

Siory Flange oo
Top Stoy
Bottom Story

Fartors

Oveistiength Factor, R

g Other Factops o

Importance Facter | |1
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 And also the load of combinations and the design codes and
- any other definition add in the old model will be imported to
the new model ....

® You can adjust the file of etabs and make it as default for the
- program for any new model this by

1. name the etab file default .edb
2. copy this file to the folder of etab program
(c/program files /computer and structure/ etabs)
3. when you begin a new model choose default .edb
and the program will imported all this data directly
Auto Line Constraints

In finite element analysis, shell elements are connected to other
elements at corner points only. When an element does not frame into
the corner point of a shell element, but instead frames into the edge of
the shell element, no connection exists between the element and the
shell element. The ETABS auto line constraints feature allows you to
specify that elements framing into the edge of a shell element be
connected to the shell element. ETABS internally takes care of
connection between the elements by constraining points lying along
an edge of the shell element to move with that edge of the element.

* Before you make Run to any Model you must make Auto
Line Constraints for the model. |
* Choose the whole building
e Click the Assign menu—p Shell/Area —p Auto
Line Constraint...

1500 : ¥ : - "; B9 i b ‘ :
i L AdelitnEl Area Mass..
ea ObjeckMesh Options:.,;

AR L Corstraii, .
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e The next form of Auto Line Constraint options Will display
Choose create line constraints around (Walls and Ramps,

Floors) thin click Ok

Auto Line Canstraiht Options.

e When you use Auto Line Constraints Options always check the
box of Apply to Full Structure

e We have example for model run with Auto Line Constraint and
another one run with Auto Line Constraints
o Model without Auto Line Constraints

R

™ Elevation View - 1 Defarmed Shape (EQ)

O]

=

e

]
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Chapter 12

o The same Model with Auto Line Constraints

Elevation View - 1 Deformed Shape (EQ)

L
L

—]

Developed Elevation:

You can develop elevation foe any part of the building as follow

P i SO Lo

Last point of

Elev. First point of
Elev.
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

To make elevation view for this part of the core

1. Click Draw menu —» Draw Developed Elevation
Definition ,thin the next form of Elevation View will be

‘dlsplayed N 2-click here
Elevation YViews to add the
— elevation to
the
elevation

1-Add the
Name of
Elevation Here

Add New Nams
, ;
: Detete Name

3-Click OK

2. After you add the name of the view Click OK button, thin
the crasser for Selection the elevation will be displayed in
the plan view. click on the first point to the end point
passing be the intermediate points like you draw it thin click
escape button |

3. click Set Elevation view Button
displayed

s , the next form will be

‘L ok} [ Cancel |

TRUNG TAM BAO TAO XAY DUNG VIETCONS VIETCONS ?
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4. select the elevation view name (ELEV1),thin click OK
button,and the elevation view will be displayed

Elev.View

Elev,
View
Location

st

Add the Geometry of the Buildings
In this step, we will draw the Structure elements using the program
utility, and we will add the same plan of our example using the
program utility
1. Add Slabs:
1. Make sure that the plan view is the view of story level ,if
not ,Click set plan view button P2 the next form will be
displayed, from this form choose story level

STORYID ~
STORYS =
STORYE
STORYT
STORYE

STORYS c
STORY4 _Cancel |

STORYS
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

2 Click the Draw menu —® Draw Area Objects —» Draw
Area

Or Draw Area button " thin the Properties of Object
form will display as shown in fig. and crasser for
drawing Area

Properties of Bhieci

¢ In previous form you can
o Choose area thickness for the Slab you was deﬁned before

from Property
o Change the local axis of area smpzs
o Using Drawing control for [bos o

drawings LA
o Set the Property item in the

box Slab 25

P
b
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I 4Direction of
Drawing

Starting
Point

3. Click on the first point for drawing as

it is mentioned in the
previous drawing

e Click Drawing Control

pull down menu and choose
Fixed dx and dy

220 i Chapter S
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Prnﬂertlea of ﬂblect

T SLABZS
0.

MNone <zpacebarr vg

{Mone <space bar>
N Parallel to X 4
{Parallel to Y <>
Parallel to Angle <4>
{Fixed Length <L>
Fixed Length and ﬁ‘-‘»nle 45}
Fived dw and dy <D =0 0

®
point

| Pmperty

| Local Axis = = e

{ Drawing Eunkrol
Fi;-:fed ds.

Write the coordinate value with reference to the starting

e Thin click any where the program will select the second

point directly

=

{30 [a ey
T
T

Property DECK1 -
| Local Axis 13
i Dirawing Conliol None <space bar

|
|

Thin for the next point Click Drawing Control pull down
menu and choose Fixed dx and dy again thin Write the

coordinate value for the next point with reference to the

previous point

VIETCONS
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e Thin click any where the program will select the second
point directly ,

Second
point

Repeate the previous step for the another points ,thin after you finish
Draw the plan it will be as in the figure.
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

2. Add Walls

4. Click the Draw menu —» Draw Area Objects —>»
Draw Walls

Draw
| sERT
% Reshape Object

{o} DrawPontObjects
’ 7 Draw Areas (Flan, Elev, 30)

; L] Draw Rectangular Areas (Plan, Elev)
[=] Create Areas at Click (Flan, Elex)

B2 Draw Dimension Line

. Draw Reference Point =i Create Walls in Region or at Click (Plary)

Snap o . % »1

Or Draw Area button = which will Display the Properties of Object

Pier
wialL40
0
Mo
‘Mone <space bar>

= In previous form you can
1. Choose Type of area (Pier , Spandrel)
2. Choose the Property of the wall
3. Make offset while drawing this wall
4. let the program make label for piers and
spandrel automatically
5. and use Drawing control option as we use it in
the slab drawing
e click for the first point of the wall .thin for the next point Click
Drawing Control pull down menu and choose Fixed dx and dy
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again thin Write the coordinate value for the next point with
reference to the first point

After you draw the walls it will be as in the fig

T Plan View - STORY1 - Elevation 4.2

First point
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

e ETABS Version 9.0.0 is a new version, and is a direct upgrade
from Version 8.5.6. New features include the following.

Added Semi-rigid diaphragm option

Added Design output to Database

Added Story vertical load, shear and overturning plots
Improved plan display of most design quantities

Improved analysis model creation time |

Enhanced Model Building of Walls with openings

Added IBC 2003 seismic and wind loads

Added auto-permutation of Wind directions and eccentricities
Added Open-structure wind loads

Added Export to SAFE V8 with poly-areas

Updated Concrete Frame Design to ACI 2005

Updated Concrete Shear wall Design to ACI 2005

Updated Steel design to AISC-ASD 2001 (Seismic Provisions
2002)

Updated Steel design to AISC-LRFD 2001 (Seismic Provisions
2002)

Updated Steel design to AISC 2005 (Not in initial release)
Added Import/Export from Autodesk Rivet Structural
Added Import/Export from ProSteel

Added Import/Export from IFC

Updated CIS/2 Import/Export

Added Import from STRUDL

Added Import from STAAD
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Main Menu

New Model

Open

Save

Print Graphics

21 Refresh Window
i Lock/Unlock button

Selection Menu
ﬁl Pointer button
Get Previous Selection
Clear Selection

Select All

Select using Intersecting Line

Snap Menu

Snap to Grid Intersections and Points

4] Snap to Line Ends and Midpoint

>4 Snap to Intersections
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Snap to Perpendicular Projections

Snap to Lines and Edges

Snap to Fine Grid

Define menu

Define Material Properties

Define Static Load

Define Load Combinations

=1 Define Frame Sections

Define Wall/Slab/Deck Sections

ag Define Mass Source
rax Define Response Spectrum Functions
A Define Response Spectrum

Assign menu

Eal Assign Frame Section
> Assign joint Rigid Diaphragm

Assign Shell/Area Rigid Diaphragm

5% Assign Joints Restraints
228
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

= Assign Point Springs
i Assign Frame Releases/Partial Fixity.

Assign End (Length) Offsets

Assign Frame Output Stations

Assign Local Axes
Assign Line Springs
Assign Wall/Slab/Deck Section
= Assign Opening
oo Assign Shell/Area Local Axes
= Assign Pier Label
29 Assign menu Spandrel Label
£t Assign Additional Area Mass
[r Assign Joint/Point Loads Force
s Assign Joint/Point Loads Temperature
0 Assign Frame/Line Point Loads
iz | Assign Frame/Line Distributed Loads
};‘ Assign Frame/Line Temperature Loads
z Assign Group Names
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Draw Objects

Draw Point Objects

Draw Line Objects

Pointer

Reshape Object

Draw Lines (Plan, Elev, 3D)

Create Lines at Regions or at Clicks (Plan, Elev, 3D)

Create Columns in Regions or at Clicks (Plan)

Create Secondary Beams in Regions or at Clicks

(Plan) | '
3353 Create Braces in Regions (Elev)
Draw Area Objects
LA Draw Areas (Plan, Elev, 3D).
ﬂ Draw Rectangular Areas (Plan, Elev)
= Create Areas at Click (Plan, Elev)
=1 Draw Walls (Plan)
=1 Create Walls in Regions or at Clicks (Plan)
QH Draw Developed Elevation Definition
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Edit Menu

Undo

Redo

Delete

Replicate |

Edit Grid

Edit Story

Merge Points

Align Points/Lines/ Edges
Move Points/Lines/ Areas
Expand/Shrink Areas
Merge Areas

Mesh Areas
Join Lines

Divide Lines

Extrude Lines to Aljeas

TRUNG TAM PAO TAO XAY DUNG VIETCONS
www.vietcons.edu.vn
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Analysis Menu

Run Analysis

|&]  Lock/Unlock Model

Display menu

Show Unreformed Shape

Show, Deformed Shape

Show Mode Shape

Display Member Force Diagram
Show Joint Loads

Show Frame Loads

Display Input Table Mode

Display Output Table Mode

Show the Response Spectrum Curves

View Command

i Set Building View Options

3d] 3D view
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Rotate 3D View
Plan View

- Move Up in List
Move Down in List

Elevation View

Perspective Toggle
Zoom- Commands

Rubber Band Zoom
Restore Full View

Previous Zoom

Zoom In One Step
Zoom Out One Step
i Pan

Design Commands

I Steel Frame Design Command
&l Concrete Frame Design Command
T Composite Beam Design Command
@g Shear Wall Design Command
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Shortcut

New Model

Print Graphics M

234

TRUNG TAM PAO TAO XAY DUNG VIETCONS Vi ETCON S
WWW.VietCOns,edu,vn ALWAYS BESIDE YOUR SUCCESS



HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM

Select Menu

Alt+ S
Assign Menu | Alt+ A
Analyze Menu | Alt+N
Design Menu _ | Alt+P
Display Menu | AL G
Options Men‘gi

Alt+0O

TRUNG TAM PAO TAO XAY DUNG VIETCONS
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el el s s @
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HOW TO MODEL AND DESIGN HIGH RISE BUILDING USING ETABS PROGRAM
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